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Introduction
Congratulations on the purchase of your new Dolphin® 7400/7450 mobile computer.  You have made a wise choice in selecting 
the Dolphin, a device known worldwide for its ergonomic shape, light weight and single-handed data collection features. 

The patented shape of the Dolphin 7400 allows true, one-handed operation and fits either hand comfortably, while the Dolphin 
7450’s integrated pistol-grip handle provides comfortable ergonomics and intuitive point-and-shoot scanning for extended 
periods of use.  

Built to last, the Dolphin’s ruggedly built case houses a 206MHz RISC processor and the Microsoft® Pocket PC operating system 
that is easily programmable with standard programming tools, eMbedded Visual Tools (includes eMbedded Visual C/C++® and 
eMbedded Visual Basic®).  The terminal provides ample, secure storage for data and applications with its 64 MB RAM and 32 
MB FLASH memory configuration. Up to 256MB additional memory for data storage is available with an optional compact flash 
card.

The Dolphin 7400/7450 terminals are some of the most durable devices available, designed to withstand repeated five-foot drops 
onto a concrete floor. The terminal also resists extreme temperatures, humidity levels and dust conditions.

The Dolphin’s collection of features also includes:  long-lasting Nickel Metal Hydride (NiMH) batteries; a large easy-to-read 240 
x 320 1/4 VGA backlit display that can display text or graphics; a natural scan and viewing angle; a low-power, high-resolution 
digital image engine for omni-directional and auto-discrimination decoding of linear bar codes; Stacked Linear and matrix codes 
and provides OCR (Optical Character Recognition) functionality and an optional Advanced Long Range laser scanner. The 
Dolphin 7400/7450 also has 802.11b direct sequence and frequency hopping spread spectrum radio options for real-time data 
collection applications.

Load up the Dolphin with your custom software application and the ultimate data collection solution for your business fits in the 
palm of your hand.  

The Dolphin 7400/7450 Mobile Computer/HomeBase User Guide is designed to provide you with the information you need to 
make the most of your new Dolphin terminal.  Sections on the basics, safety, battery use, accessories, and service make this 
guide a complete source of information.
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Safety

The Dolphin 7400/7450 mobile computer meets or exceeds the requirements of all applicable standards organizations for safe 
operation.  However, as with any electrical equipment, the best way to ensure safe operation is to know the possible risks.  

The following safety guidelines are designed to protect both you and others around you. Please read them carefully before using 
your Dolphin terminal.

Required Safety Labels

Batch Terminals

The following is the required safety label that appears on the back panel of Dolphin 7400/7450 batch terminals equipped with an 
imager:

The following are the required safety labels that appear on the back panel of  Dolphin 7400/7450 batch terminals equipped with 
a laser scanner:
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If Your Dolphin 7400/7450 has a WLAN radio
The Dolphin® 7400/7450 RF terminal is designed to comply with the most current applicable standards on safe levels of RF 
energy developed by the Institute of Electrical and Electronics Engineers (IEEE) and the American National Standards Institute 
(ANSI) and has been recommended for adoption by the Federal Communications Commission (FCC). 

The following is the the required safety label that appears on the back panel of the Dolphin 7400/7450 RF terminals equipped 
with a Cisco® 352 radio and an imager:

The following is the the required safety label that appears on the back panel of the Dolphin 7400/7450 RF terminals equipped 
with a Spectrum24® radio and an imager:

The following is the the required safety label that appears on the back panel of  Dolphin 7400/7450 RF terminals equipped with 
an laser scanner:
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FCC Compliance 

Dolphin 7400/7450 Batch Terminal

The Dolphin 7400/7450 Batch complies with part 15 of the FCC rules. Operation is subject to the following two conditions:

1. Devices may not cause harmful interference.

2. Devices must accept any interference received, including interference that may cause undesired operation.

Dolphin 7400/7450 RF Terminal with Cisco® 352 or Spectrum24® (LA 3021) Radio

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:(1) this device may not 
cause harmful interference, and (2)this device must accept any interference received, including interference that may cause 
undesired operation.

In accordance with FCC 15.21, changes or modifications not expressly approved by the party responsible for compliance could 
void the user’s authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

If necessary, the user should consult the dealer or an experienced radio/television technician for additional suggestions. The user 
may find the following booklet helpful:  "Something About Interference." This is available at FCC local regional offices. Our 
company is not responsible for any radio or television interference caused by unauthorized modifications of this equipment or the 
substitution or attachment of connecting cables and equipment other than those specified by our company. The correction will 
be the responsibility of the user. Use only shielded data cables with this system.

In accordance with FCC 15.21, changes or modifications not expressly approved by the party responsible for compliance could 
void the user’s authority to operate the equipment.

CAUTION: To comply with FCC RF exposure compliance requirements, a separation distance of at least 2 inches (5 cm) 
must be maintained between the antenna of this device and all persons (excluding hands, wrists, feet and ankles), 
during normal operation.

This device and its antenna must not be co-located or operating in conjunction with any other antenna or transmitter.

This device is not specified or designed for body-worn configurations.  Use of any body-worn accessories may not 
ensure compliance with the FCC RF exposure guidelines.

Canadian Compliance

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.
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Regulatory and Safety Agency Approvals

The CE mark on the product indicates that the system has been tested to and conforms with the provisions noted within the 89/
336/EEC Electromagnetic Compatibility Directive and the 73/23/EEC Low Voltage Directive.

Dolphin 7400/7450 RF Spectrum24® 3021 R&TTE Compliance Statement
The Hand Held Products Dolphin 7400RF and Dolphin 7450RF are in conformity with all essential requirements of the R&TTE 
Directive (1999/5/EC).   This equipment has been assessed to the following standards:

This product is marked with     in accordance with the Class II product requirements specified in the R&TTE 

Directive, 1999/5/EC.

The equipment is intended for use throughout the European Community, but it’s authorisation for use in France is restricted as 
follows:

PAN European Frequency Range: 2.402 - 2.480 GHz

Restricted Frequency Range for use in France: 2.448 - 2.480 GHz

Parameter Specification

U.S.A.

Canada

Europe

Mexico

Others

FCC Part 15, Class B

IEC 0003

EN 55022 (CISPR22) Class B
ETS 300 826 Type Certified

NOM Certified

EMC 89/336/EEC
EN 50082-1:1997, EN55024 

RF Approvals

U.S.A
Canada
Europe
Mexico

FCC Part 15.247
RSS 210 Certified
ETS 300 328 Certified
Telecom RCPHAD002-485

Parameter Specification

R&TTE EN 300 328-2:2000
EN 301 489-1 (August 2000)
EN 301 489-17 (Sept 2000)
EN 60950: 1992 Incl Amdt 1-4,11
EN 50361: 2001
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Dolphin 7400/7450 RF Cisco® 352 R&TTE Compliance Statement
The Hand Held Products Dolphin 7400RF and Dolphin 7450RF are in conformity with all essential requirements of the R&TTE 
Directive (1999/5/EC).  This equipment has been assessed to the following standards:

This product is marked with    in accordance with the Class II product requirements specified in the R&TTE 
Directive, 1999/5/EC.

The equipment is intended for use throughout the European Community, but its authorization for use in France is restricted as 
follows:

PAN European Frequency Range: 2.402 - 2.480 GHz

Restricted Frequency Range for use in France: 2.448 - 2.480 GHz

For further information please contact,

HHP EMEA

Nijverheidsweg 9

Eindhoven , 5627 BT

Netherlands

Canadian Radio certification: 1693 B12143

HHP shall not be liable for use of our product with equipment (i.e.,power supplies, personal computers, etc.) that is not CE 
marked and does not comply with the Low Voltage Directive.

Pacemakers, Hearing Aids and Other Electrically Powered Devices

Most manufacturers of medical devices adhere to the IEC 601-1-2 standard.  This standard requires devices to operate properly 
in an EM Field with a strength of 3V/m over a frequency range of 26 to 1000MHz. 

The maximum allowable field strength emitted by the Dolphin is 0.3V/m according to Subpart B of Part 1 of the FCC rules. 
Therefore, the Dolphin RF will have no effect on medical devices that meet the IEC specification. 

Microwaves

The radio in the Dolphin RF terminal operates on the same frequency band as a microwave oven.  Therefore, if you use a 
microwave within range of the Dolphin RF terminal you may notice performance degradation in your wireless network. However, 
both your microwave and your wireless network will continue to function.

The Dolphin Batch terminal does not contain a radio, and therefore, is not affected by microwave ovens.

Batteries

The following are general guidelines for the safe use and disposal of batteries:

• Use only the battery supplied with your Dolphin or a replacement battery supplied, recommended, or approved by HHP. 
• Replace a defective battery immediately as it could damage the Dolphin terminal.
• Never throw a used battery in the trash.  It contains heavy metals and should be recycled according to local guidelines. 
• Don’t short-circuit a battery or throw it into a fire. It can explode and cause severe personal injury.

Parameter Specification

R&TTE EN 300 328-2:2000
EN 301 489-1 (August 2000)
EN 301 489-17 (Sept 2000)
EN 60950: 1992 Incl Amdt 1-4,11
EN 50361: 2001
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• Excessive discharge damages a battery. Recharge the battery when your Dolphin indicates low battery power.
• Although your battery can be recharged many times, it will eventually be depleted.  Replace it after the recommended usage 

period (about 600 charge/discharge cycles for the 2700 mAh NiMH battery) or if the battery is unable to hold an adequate 
charge.

• If you are not sure the battery or charger is working properly, please send it to Hand Hand Products or an authorized HHP 
service center, for inspection.  

The Dolphin hand held computer meets or exceeds all applicable standards and has been manufactured to the highest level of 
quality.

Care and Cleaning of the Dolphin

When needed, clean the image engine/laser scanner window and the LCD display with a clean non-abrasive, lint-free cloth.
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Getting Started
The Dolphin® 7400/7450 is a mobile computer/imager designed for easy, single-handed data collection.  The 
terminal is equipped with a StrongARM™ 206MHz RISC processor built to run the Windows® Pocket PC 
operating system.

Dolphin 7400/7450 computers are available with different types of 2D imagers, wireless radios, and memory 
configurations to meet most any automated data collection requirement.  

The Dolphin 7450 terminal’s integrated pistol-grip handle provides comfortable ergonomics and intuitive point-
and-shoot scanning for extended periods of use.

Offered with a memory configuration of 64 MB RAM and 32 MB FLASH, the device has three keyboard options 
and a 240 x 320 pixel, backlit 1/4 VGA display. 

The Dolphin 7400/7450 platform is equipped with an integrated imager. The imager can take images like 
shipping manifests, recipient signatures, while at the same time, decode OCR (Optical Character Recognition) 
fonts. The imager can also decode standard linear and two-dimensional symbologies.  An optional Advanced 
Long Range laser scanner is also available for both terminals.

Accessories for the Dolphin 7400/7450

The Dolphin 7400/7450 is part of a data collection system that includes accessories specifically designed for 
vehicle, desktop and hub operations.  Accessories available include serial and networkable communications/
charging cradles, vehicle mounted charging/communication cradles.

You can use these accessories with the Dolphin:

Dolphin IntelliBase™  Dolphin terminal charging and communication cradle for communicating with devices 
such as printers and modems without integrated IrDA protocol software, includes power adapter.

Dolphin USB HomeBase for communicating directly with a USB-compatible host computer, includes power 
adapter.

Dolphin IntelliBase+™ for communicating with devices such as printers and modems without integrated IrDA 
protocol software, and for charging and conditioning a spare battery, includes power adapter.

Dolphin Mobile IntelliBase for  communicating and charging Dolphin terminals in mobile environments; 
includes cigarette lighter adapter or power cable and mounting bracket.

Dolphin Mobile Base for  communicating and charging Dolphin terminals in mobile environments especially 
in-premise industrial environments; includes cigarette lighter adapter or power cable and mounting bracket.

Dolphin  Quad Battery Charger™  Charges four batteries in under three hours and conditions in under eight 
hours.

Dolphin HomeBase™ Power Adapter   Replacement power adapter for Dolphin HomeBase.  

Note: Use only power adapters approved for use by HHP.  Failure to do so may result in improper operation 
or damage to the unit and will void the warranty.

NiMH Battery Pack   Nickel Metal Hydride (NiMH) 2700mAh rechargeable battery for the Dolphin.

RS-232 Serial Cable   Allows Dolphin 7400 to connect to other computer systems for file transfer or to connect 
Dolphin 7400 terminal using the terminal’s serial RS-232 interface.

Charging and Communcations Cable

Contact your Value-Added Reseller for more information. For details about how to install or use any of these 
accessories, refer to the documentation provided with the product. Documentation may also maybe 
downloaded from our website, www.hhp.com. 

Dolphin 7400/7450 Models and Options

Hand Held Product’s family of Dolphin 7400/7450 mobile data collection terminals includes these models:

The Dolphin® 7400 Batch terminal is a Windows® Pocket PC programmable mobile computer with a unique, 
ergonomic shape designed for single-handed use. The standard Dolphin 7400 is available with 64 MB RAM 
and 32 MB FLASH and an integrated digital imager or Advanced Long Range (ALR) laser scanner. An optional 
compact FLASH card offers up to 256MB of additional memory. The terminal's RS-232 connector supports 
external plug-in scanners, land line modems and printers.  It also features an IrDA infrared transceiver for data 
communicate to portable printers and cradles.
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The Dolphin® 7450 Batch mobile computer offers the same enhanced productivity features of the Dolphin® 7400 terminal with 
the added convenience of a pistol grip-style form factor for high volume scanning applications. 

The Dolphin® 7400 RF and Dolphin® 7450 RF terminals integrate the basic functionality of the Batch terminals with the choice 
of an 802.11b or a Spectrum24™radio that allows the terminal to communicate with a host computer via a radio wireless local 
area network (WLAN).

Image Engine Options and Bar Code Symbologies Supported 

Dolphin 7400/7450 terminals may be equipped with one of three image engines options: 

• LX: red or green aimer option scans from 2.0 to 15.0 in. (5.1 to 38.1 cm.) 
• LR: red or green aimer option scans from 1.9 to 9.4 in. (4.8 to 23.9 cm.)   
• HD: red or green aimer option scans from 1.6 to 3.9 in. (4.1 to 9.9 cm.)

1D symbologies supported are: Code 3 of 9, Interleaved 2 of 5, EAN, Codabar, Code 11, Code 128, Code 93, TLC39, Universal 
Product Code (UPC), RSS. 

2D symbologies supported are: PDF417, MaxiCode, Data Matrix, QR, EAN.UCC, Aztec, Code 49. 

Composite codes supported are: RSS-14, CODABLOCK, Aztec Mesa. 

OCR codes supported include: OCR A and OCR B.

Postal codes supported include: Postnet and most international 4 state codes, PLANET CODE, BPO 4 STATE, Canadian 4 
State, DUTCH POSTAL, AUSTRALIAN 4 STATE, JAPANESE POSTAL.

Laser Engine Options and Symbologies Supported

Dolphin 7400/7450 terminals may be equipped with an Advanced Long Range (ALR) laser engine. The ALR engine reads 30mil 
bar codes from 2.75 to 8 ft (0.83 to 2.4 m) and 100mil reflective bar codes out to 30 ft (9.1 m), making it ideal for use in warehouse 
applications. 

1D symbologies supported are: UPC/EAN, Code 39, Interleaved 2 of 5, Codabar, Code 128, MSI, Plessey. 

Using Dolphin 7400/7450 for the First Time

Follow these steps to begin using your Dolphin 7400/7450 terminal.

1. Unpack and check the terminal and documentation.

2. Charge the main battery pack and internal back-up battery. 

3. Start the Dolphin mobile computer. 

4. Follow the Pocket PC set-up instructions to setup the mobile computer.

5. Set up communications with Detectoid™.

6. Verify that the Dolphin 7400/7450 terminal is working properly.

1  Unpack the Carton and Check Its Contents 

Inspect the package to see that the following standard items and accessories (if ordered) are included: 

• Dolphin 7400/7450 mobile computer/imager/scanner
• Battery (2700 mAh, Nickel Metal Hydride [NiMH])
• Dolphin 7400/7450 Software Development Kit & User’s Guide CD-ROM
• Stylus
Note: Be sure to keep the original packaging in the event that the Dolphin terminal or IntelliBase should need to be returned for 

service.
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2  Charge the Main Battery and Backup Battery

WARNING Use only 2700 mAh NiMH battery packs provided by HHP.  The use of any other battery pack in the Dolphin terminal 
will void your warranty and may result in damage to the Dolphin terminal or battery.  

The terminal’s NiMH battery is not conditioned at the factory and is shipped discharged of all power and inserted in the Dolphin 
terminal. 

WARNING Although the Dolphin 7400/7450 terminal is received with the battery inserted, it is NOT ready for charging and/or 
deep-cycling. Remove the plastic insulator located between the terminal and battery connectors. Failure to remove the insulator 
may result in damages to the terminal.

For maximum battery life, HHP recommends that you deep-cycle the battery twice before initial use. It is also recommended that 
you service the battery once per month. Refer to the section on Managing Battery Power in Chapter 3 for further information on 
deep-cycling the battery. 

After deep-cycling the battery, the terminal’s NiMH battery must be charged before using it for the first time.  To charge the main 
battery pack:

1. Place the main battery pack in the Dolphin 7400/7450 terminal.

2. Place the terminal in the terminal well of the Dolphin HomeBase.  Time to Charge:  3.5 hours for the main battery; 8 hours for 
the back-up battery

As the main battery pack charges, the internal back-up battery also charges. For the initial charging cycle, it is recommended 
that the terminal be charged for approximately eight hours to allow adequate charging time for the back-up battery.  Not doing 
so may result in the terminal becoming unstable should the unit lose power and the back-up battery is required. The back-up 
battery maintains the RAM and clock when the NiMH main battery pack is discharged or removed from the terminal. 

Removing the Battery Pack

Follow these steps to remove the Dolphin battery pack.

1. Hold the Dolphin with the front panel (keyboard) facing down.

2. On the 7400, remove the handstrap by pushing its clip down and forward to unhook it from the terminal; move the strap away 
from the battery compartment.

3. Push the locking tab on the battery pack up and pull the battery out from the Dolphin terminal with a hinging motion.

Installing the Battery Pack

Follow these steps to install the Dolphin 7400 battery pack.

1. The Dolphin 7400 ships with the handstrap installed. Hold the terminal with the front panel (keyboard) facing down. Push the 
clip of the handstrap down and away from the terminal to unhook it; move the strap up and away from the battery compart-
ment.

2. Insert the end without the locking tab into the top of the battery opening and snap the battery into place with a hinging 
motion. Press the battery into the well until the clip is engaged. The battery case serves as the back cover of the Dolphin.

3. Reattach the handstrap by positioning it down over the battery case and sliding the clip back into the place at the bottom end 
of the 7400.

Follow these steps to install the Dolphin 7450 battery pack.

1. Hold the terminal with the front panel (keyboard) facing down. 

2. Insert the end without the locking tab into the top of the battery opening and snap the battery into place with a hinging 
motion. The battery case serves as the back cover of the Dolphin.
2 - 3



3  Start the Dolphin 7400/7450 Mobile Computer

Starting the Dolphin 7400/7450 for the first time is a cold boot.  Follow these steps to start your Dolphin 7400/7450 mobile 
computer.

1. Install the charged battery pack in the Dolphin.

2. The red LED will come on and the green LED will blink for approximately three  seconds.                                                                                                                        
NOTE: DO NOT PRESS ANY KEYS WHILE THE TERMINAL IS BOOTING UP. 

3. The terminal will initialize and will display the HHP splash screen for a few seconds. 

4. When the Welcome screen shown below displays, tap the screen to set up the Dolphin mobile computer.

Dolphin 7400/7450 Splash Screen
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4 Align the Screen and Set the Time Zone 

Aligning the Screen

You will be prompted to align the screen after a cold boot.  Alignment can also be performed by going to Start>Settings and 
then  choosing ‘Screen’ on the "Systems" tab.  Follow the directions on the screen to align the screen and keep the following 
points in mind:

• After the Welcome splash screen appears, you will be prompted to calibrate the screen. The Dolphin 7400/7450 terminal 
displays a cross-hair target and a message to "Tap the target firmly……".

• Use the stylus shipped with your Dolphin mobile computer. Alignment should always be performed with a stylus designed 
for touchscreen applications.  The small point is required for accurate calibration.  

• The stylus should be oriented at a 90 degree angle to the screen surface.   Press the stylus firmly into the center of the cross-
hair target and release. Do not "double-tap" the target.  You will be prompted to repeat this process for a total of five targets. 

• After aligning the screen, follow the directions on the screen which take you through a simple exercise showing how to use 
the stylus and pop-up menus.

Tapping the Target

Using Pop-Up Menus
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Note: HHP recommends using screen protectors for Dolphin 7400/7450 terminals; especially for those  terminals used for 
applications that require high-volume interfacing with the touch display. Screen protectors will help prevent damage to 
the touch panel display and are easily installed over the display. Screen protectors can be purchased at any major 
computer retail store.

Setting the Time Zone

After screen alignment is completed, the Location screen shown below displays. Use the drop-down menu to set your time zone, 
and tap Next. 

After setting the time zone, you are finished with the initial setup of your Dolphin mobile computer. 

Setting Time Zone Screen
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Setting the Time and Date
The Time and Date screen does not display after setting the time zone. Go to Start>Settings>Systems Tab>Clock to set the date 
and time after a cold boot.

Setting Time and Date
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5  Setting Up Communications with Detectoid™

The Detectoid™ Communication Utility makes it easier to set-up communications between your PC and Dolphin 7400 or 7450 
terminal. The utility has two components: DetectoidPC™ for setting up ActiveSync® on the PC and DetectoidCE™ for setting 
communication parameters on the Dolphin terminal.

Installing DetectoidPC™

The DetectoidPC.exe file is located in the \Utilities\PC directory on the user’s CD that is shipped with the Dolphin terminal.  Users 
may run the executable right from the CD-ROM, or they can copy it to their machine.  

System requirements for installing DetectoidPC on your PC are:

Operating system:   Windows® 98, 2000, or XP

Free disk space:      Less than one megabyte

Using DetectoidPC™ and DetectoidCE™
Use DetectoidPC to configure the ActiveSync® settings on your PC for communication with a Dolphin terminal. Detectoid PC 
sets the baud rate and configures the COM port for ActiveSync. Once the settings are configured, you can save them and your 
PC is always ready to connect with the Dolphin terminal. 

Before starting, ensure that your Dolphin is connected via serial cable or docked in a working IntelliBase. 

If ActiveSync is detected to be running on the PC when DetectoidPC is started, the following message will appear:

DetectoidPC Screen as seen on Host PC DetectoidCE Screen as seen on Dolphin 7400/
7450
2 - 8



Click OK to continue using DetectoidPC to set up communication settings.

On starting, DetectoidPC will check for the availability of COM ports, as well as IrDA/USB support. Once the terminal is detected, 
the port status will change from “Idle” to “Listening” as shown in the screen shot above.

DetectoidCE
After running DetectoidPC, start Detectoid CE on the Dolphin terminal selecting Start>HHP>DetectoidCE. 

DetectoidCE will attempt to find the connection with the PC. If successful, the discovered settings will be saved. Touch OK and 
the terminal is now configured for ActiveSync to start automatically when the terminal is connected via a powered serial cable or 
docked in a powered IntelliBase. See chapter 12 for information if you prefer to manually start ActiveSync to establish 
communications.

If you want to go back and change the settings later, select Start>Settings>Control Panel>Communication Properties and 
select the Launch tab.

                                             

Once the communications parameters have been detected and configured, the status indicator will change to “Success”. Verify 
that the ActiveSync settings are correct, then click save to transfer those settings to ActiveSync. 
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Follow these steps to establish a connection for the first time after configuring the settings:

1. Select Launch ActiveSync in the DetectoidPC window.

2. Start ActiveSync on the Dolphin terminal.

Once parameters are configured and saved, you do not need to run DetectoidPC again unless you need to change the 
ActiveSync settings or cold-boot the terminal. 

6 Verifying that Dolphin 7400/7450 is Working Properly

After you have completed the initial setup  and set the time and date, the Dolphin 7400 terminal is ready to use. Choose the 
IMAGE DEMO or SCAN DEMO to verify that the terminal is operating properly.

To take an image:

1. Touch the <Start> button and tap HHP Demos.

2. Select IMAGE DEMO. 

3. Press the <ON/SCAN> button and the image you take will appear on the terminal’s screen. 

4. Touch <ESCAPE> to go back to the main menu.

To scan a bar code:

1. Touch the <Start> button and tap HHP Demos.

2. Select SCAN DEMO. 

3. Press the <ON/SCAN> button, aim the terminal at a bar code and the red SCAN LED will illuminate. The green SCAN LED 
will illuminate and the terminal will beep when a good scan is obtained. Information about the bar code scanned will appear 
on the screen. 

4. Press <ESCAPE> to exit the demo and return to the main menu. 
2 - 10



Putting the Dolphin Into Suspend Mode

To conserve power, press and hold the backlight key for approximately three seconds to put the Dolphin terminal into suspend 
mode.  The terminal may also go into “suspend mode” when it is inactive for a programmed period of time, as defined by your 
application.  Press the ON/SCAN key to wake the Dolphin terminal from suspend to start working where you left off. 

The Dolphin terminal also goes into sleep mode if you remove the main battery pack. To wake the Dolphin terminal from sleep 
mode, install a charged battery and press the ON/SCAN key. 

WARNING If the main battery and back-up battery are ever fully discharged of power, the terminal will cold boot. The 
terminal will be restored to its original state. All data stored in RAM memory also will be lost.

Resetting the Dolphin (Cold Boot)

Under some conditions, you may need to reset the Dolphin 7400/7450 terminal with a cold boot. These may include: 

• Resetting the operating system 
• Resetting the terminal back to factory defaults
• Resetting the terminal after a bootloader, keyboard, and kernel upgrade

To perform a cold boot:

1. Press and hold the Control (CTRL) and the Escape (ESC) keys for about 10 seconds.

2. Release the keys and the terminal will reset. The red LED will come on and the green LED will blink for approximately 3 
seconds. 

3. The terminal will behave as described in the section about Starting the Dolphin for the First Time. 

Resetting the Dolphin (Warm Boot)

There are times when you may need to warm boot the Dolphin 7400/7450 terminal, such as after loading a software application 
that requires a warm boot after installing new software. To warm boot the Dolphin 7400 terminal:

1. Press and hold the Control (CTRL) and the SHIFT (SFT) keys for about 10 seconds, then release.  

2. Release the keys and the terminal will reset. The red LED will come on and the green LED will blink for approximately 3 
seconds. 

3. The terminal will initialize and after a few seconds will display the main menu screen for the Dolphin 7400/7450 Demo 
Program.
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3

Dolphin 7400/7450 Overview
System Features

Processor
The Dolphin® 7400/7450  with Microsoft Pocket PC terminal is equipped with a StrongARM® 206MHz RISC microprocessor that 
runs on a 100 MHz BUS and is the most powerful Pocket PC platform on the market.

Operating System
Microsoft® Pocket PC is a compact, highly efficient, scalable operating system. Its open architecture facilitates development of 
applications for energy-efficient data collection devices like the Dolphin 7400/7450 terminal. The graphical interface also makes 
the device more user-friendly.

Memory
Main Board

The memory configuration for the Dolphin 7400/7450 wi terminals is 64 MB RAM and 32 MB FLASH.

Compact Flash Card

Dolphin 7400/7450 terminals have one Type I compact flash card socket for additional application and data storage capacity. 
Additional modular compact flash upgrades of 64 MB, 128 MB, and 256 MB are available through an authorized HHP service 
center. The compact flash card socket is not user accessible, to preserve the terminal’s environmental rating. 

Radio Options
Dolphin 7400/7450 terminals have one Type II PCMCIA card slot to allow for an interface with wireless network adapter cards. 
Radio cards currently certified include the Cisco® 352 (FCC #HD5-7400-352) series network cards and  the Spectrum24® (FCC 
#HD5-7400-3021) card .
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Front Panel Features

This section describes features on the Dolphin 7400/7450 terminal front panel. 

Decode LED Scan LED

1/4 VGA Display with 
touch screen

Cursor Key

ON/SCAN Key

Keypad with epoxy-
coated keys
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LEDs
The red light emitting diode (LED) located at the upper right corner of the LCD display is SCAN LED. This LED illuminates when 
the user presses the ON/SCAN key and activates the scan engine. The green LED located at the upper left corner of the LCD 
display is DECODE LED. This LED illuminates when the bar code software successfully decodes a bar code. Both LEDs are 
software programmable.

1/4 VGA Display
The Dolphin 7400/7450 screen is a 240 x 320 pixel 1/4 VGA industrial protective lens display. The electroluminescent backlight 
allows you to view the display in low light conditions.  To conserve power, the backlight may be programmed to automatically 
turn off after a prescribed amount of time. The contrast may be adjusted with the contrast keys.  The Dolphin 7400/7450 display 
is equipped with a touchscreen that can be activated with a stylus or finger.

ON/SCAN Key
The ON/SCAN key is centrally located for easy use with the right or the left hand. On the 7450 terminal, the ON/SCAN key 
operates as an On or system wakeup control; scanning is activated with the handle trigger.

Cursor Keys
The centrally located cursor keys allow full Windows® Pocket PC navigation.

Audio Signals
The Dolphin 7400/7450 terminal has an internal speaker that sounds audio signals as you scan bar code labels and enter data. 
Signals are emitted at a sound level of 80 dB sound pressure level at two feet. The operating frequency range is 500 Hz up to   
8 kHz. The speaker can also be used for playing sounds using WAV files.
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Keyboard
The Dolphin 7400/7450 terminal’s keyboard features epoxy-coated keys and is backlit for easy use in dark and dim lighting 
conditions. The keyboard’s yellow background enhances the readability of the numeric keys. The centrally located ON/SCAN 
key and other important keys allow for easy imaging, bar code scanning and application navigation. All keyboard versions are 
suited for right-handed and left-handed use.

There are three keyboard options for the Dolphin 7400/7450 terminals:  43-key alpha/numeric, 35-key numeric/alpha and 56-key 
alpha/numeric.

RF Antenna
The Dolphin 7400/7450 RF terminal’s antenna is a unity gain, quarter-wave, monopole antenna.

 43-key 
alpha/numeric keyboard

35-key numeric/alpha 
keyboard

56-key 
alpha/numeric keyboard
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Back Panel Features

This section describes features on the back panels of the Dolphin 7400 and Dolphin 7450 terminals. 

Dolphin 7400
All versions of the 7400 terminal have similar back panels except for the safety labels specific to how the the terminal is equipped.

Image Engine
Dolphin 7400/7450 terminals are equipped with an image engine that reads and decodes linear, stacked linear (PDF417) and 
2D matrix bar code symbologies. With the latest CMOS-based technology, the engine works like a digital camera and adds 
functionality and value to the Dolphin 7400/7450 by adding additional capabilities, such as digital image capture, signature 
capture and reading OCR characters. Digital images taken with the 7400/7450 terminal have a maximum image size of 640 x 
480 pixels and may have up to a 256 gray scale image definition. Files formats supported for image storage include Bitmap 
(bmp), JPEG (jpg) and Portable Network Graphics (png).

Battery 
Well

Battery 

RS-232 
Port

IrDA Port

Hand 
Strap

Battery 
Charging 
Contacts

Image 
Engine/
Laser 
Engine 
Window 

Stylus
Holder
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Laser Engine
Dolphin 7400/7450 terminals are also available with an optional Advanced Long Range (ALR) laser scanner for long range 
scanning applications prevelant in warehousing and distribution centers.

A clear window with anti-reflective, scratch-proof coating covers the image/laser engine to protect it from dust and dirt.

Battery Well
The Battery well is a recessed area on the back of the Dolphin that holds the 2700 mAh NiMH battery pack.

Battery Charging Contacts
When the Dolphin is placed in the main well of the Dolphin IntelliBase, the Dolphin’s battery pack is charged through these gold-
plated contacts.

Hand Strap 
The 7400 has an integrated elastic hand strap with two elastic slots to provide the user with a convenient place for storing the 
stylus and a comfortable, secure grip on the terminal. If desired, the strap may be removed. 
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Dolphin 7450
The bottom cover of the Dolphin 7450 terminal is similar to the Dolphin 7400 as described in the previous section with the 
following exceptions: the pistol-grip handle with a place to store a stylus and an imager/scanner trigger and the rubber bumpers. 
All versions of the 7450 terminal have similar bottom covers except for the safety labels specific to how the terminal is equipped.

Rubber Nose 
Bumpers

HandleScan Trigger
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Rubber Nose Bumpers
Rubber bumpers allow the Dolphin 7450 to rest in a stable, nose-down position  when the unit is set on a flat surface by the user.

Scan Trigger
The scan trigger provides comfortable two-finger scan activation.

Pistol Grip Handle
The comfortable, ergonomic handle is designed especially for use in rapid, high volume scanning applications and features 
rubber surface details for improved handle grip, comfort, and shock absorption.

Communication

Micro-DB9 RS-232 Port
The industry-standard RS-232 port allows the user to connect with peripherals, such as printers, serial modems and desktop 
computers for serial communication to the Dolphin 7400/7450 terminal. The maximum speed is 115kbps with seven baud rate 
settings. The port also supports power so that you charge the terminal.

IrDA Port
The IrDA (Infrared Communications) Port allows the Dolphin to communicate through the Dolphin IntelliBase and IntelliBase+ to 
host serial devices or IrDA printers. The maximum speed is 115kbps.

Rubber Bumpers
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Power

5 VDC  Port 
This port connects the Dolphin 7400/7450 to DC power for powering peripheral devices and charging the main and backup 
batteries.

Power is fed through the RS-232 communications port.

Batteries
CAUTION:  Use only the 3.6V battery packs provided by HHP. The use of any other battery pack in the Dolphin 7400 
terminal will void your warranty and may result in damage to the Dolphin terminal or battery.

There are two batteries in the Dolphin:

Internal NiMH Backup Battery Located inside the Dolphin, this battery backs up the RAM and clock when the NiMH main 
battery is discharged or removed from the terminal. The internal backup battery is not user replaceable.

NiMH Battery Pack The battery pack is the primary power source for operating the Dolphin terminal.

Internal NiHM Backup Battery
The Dolphin’s internal backup battery prevents the terminal from being reset if you need to remove and replace the main battery 
pack.  The battery retains RAM data and allows the real-time clock to remain operational for up to 30 minutes when the battery 
pack is removed.  For the initial charging cycle, it is recommended that the terminal be charged for approximately 8 hours to allow 
adequate charging time for the back-up battery.  Not doing so may result in the terminal becoming unstable should the unit lose 
power and the backup battery is required.

If the backup battery becomes discharged of power after the initial charge cycle, it will require a minimum of 5 hours of charging 
time to perform and maintain the system as described above.

The internal backup battery is charged by the Dolphin’s main battery pack when an external power source such as the Dolphin 
IntelliBase, is not available.  If the terminal is left without the main battery pack for more than 30 minutes, the internal backup 
battery will need to be recharged.  

Note: Data and programs stored in FLASH remain safe even if the internal backup battery fails. However, you must reset 
the real-time clock using the Pocket PC Time and Date function.

Follow these guidelines to maximize the life of the Dolphin’s backup battery:

• Keep a charged NiMH battery pack in the Dolphin. The internal battery will prematurely discharge if there is not at least a 
partially charged battery in the terminal.

• Put the Dolphin in the IntelliBase when the terminal is not in use. 

Main Battery Pack
The 3.6V, 2700 mAh Nickel-Metal-Hydride (NiMH) battery pack is the primary power source for the Dolphin.  Other NiMH 
batteries may be approved by HHP to work with your Dolphin.  Contact HHP for more information. 

The 2700 mAh NiMH battery is designed to operate in a temperature range of -10 to 50°C (14 to 122°F).  For maximum 
performance, charge the batteries between 10 and 35°C (50 and 95°F).

Managing Battery Power

Data and files saved on the Dolphin 7400/7450 terminal may be stored in RAM, so it is important to maintain a continuous power 
supply to the terminal. When the main battery pack becomes low, the Low Battery Charge icon will appear in the notification tray 
at the top of the screen. The Critical icon will appear when the battery is critically low. There is also a Low Battery icon that will 
appear when the back-up battery is low.

Letting the back-up battery become fully discharged will cause the terminal to lose all data in RAM. Therefore, you should keep 
a charged battery pack in the Dolphin at all times to conserve the internal back-up battery.  When you remove a battery pack, 
insert another charged pack in the Dolphin. The internal battery will prematurely discharge if there is not at least a partially 
charged battery in the terminal. 

A battery status indicator will display in the notification tray when the battery is low or critically low. If there is no indicator, the 
battery is adequately charged.

If the main battery is low and the terminal is in sleep mode, pressing the ON/SCAN button or the scan trigger will not wake up 
the Dolphin 7400/7450 terminal; you must replace the discharged battery with a fully charged battery.
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Setting Critical and Low Battery Points
The Dolphin 7400/7450 may be programmed to display warnings when the battery reaches critical and low battery points. There 
are two entries defined in the registry. The specific settings are:

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Power]

"CriticalBatt"=dword:a

"LowBatt"=dword:19

"CriticalBatt"=dword:F 

This sets the Critical Battery point to 15 percent (a hex = 15 decimal). The critical battery is the point at which the customer is 
warned that the battery charge is very low. This warning will be posted every 3 minutes until the situation is corrected.

"LowBatt"=dword:19

This sets the Low battery point to 25 percent (19 hex = 25 decimal). The low battery setting is the point at which the user is alerted 
that the battery is low. The user is notified only once for a low battery.

These are the default values. Developers can set these parameters from 0 (no warning at all) to 99 (would nearly always warn). 
The warnings do not appear when the terminal is on external power.

Checking Battery Power
The Battery Status screen displays information about current battery status and allows you to set options that can conserve 
battery power.

To open the Battery Status screen:

1. Select Start>Settings>System>Power. 

2. Select your preferences.

3. Tap OK to save the changes and exit. 

Servicing the Battery Pack
For maximum battery life, you must service, or deep cycle, the battery twice before initial use. It is also recommended that you 
service the battery once per month. To deep cycle, insert the battery into the auxiliary well of the Dolphin Intellibase+ charging/
communication cradle, Dolphin QuadCharger or use the Battery Conditioning Utility. See Chapter 12 for more information on 
using the IntelliBase+ and Chapter 13 for information on using the QuadCharger. 

Using  the Battery Conditioning Utility

The Battery Conditioning Utility is used to condition or deep cycle a battery in the Dolphin 7400/7450 terminal. The discharge/
charge cycle minimizes battery memory effects and ensures the battery data is correct. A complete discharge/charge cycle may 
take up to 15 hours for a fully charged battery. The actual cycle time will vary depending on the battery state when the cycle was 
initiated. 

Follow these instructions to use the Battery Conditioning Utility to deep cycle the battery before initial use:

1. Put the battery pack in the Dolphin terminal.

2. Connect the Dolphin 7400/7450 terminal to external power or place the terminal in the IntelliBase. After starting the Battery 
Conditioning Utility, the Dolphin will beep and then indicate an error if the terminal is not on AC power.

3. Select Start>Programs>HHPUtils>Battery Conditioning to start the Battery Conditioning Utility.

4. Touch the ‘Start’ button on the screen (or the ‘S’ key) to start the battery conditioning process. The terminal will beep and the 
process will begin in approximately 60 seconds.

To cancel battery conditioning, touch the ‘Abort’ button (or the “A” key). The terminal will beep and the process will be aborted. 
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Charging the Battery Pack
You can charge the Dolphin’s main battery pack with one of the following methods:

• Place the battery pack in the Dolphin 7400/7450 terminal and then place the terminal in the terminal well of a charging/
communication cradle.

• Place the battery pack in the Dolphin Quad Battery Charger.
• Place the battery back in the Auxiliary Battery Well of the IntelliBase+. 

Storing Batteries
To maintain top performance from batteries, follow the guidelines below when storing them:

Avoid storing batteries outside the specified range of -4 to 104° F (-20 to 40°C) or in extremely high humidity.

For prolonged storage, do not keep batteries stored in a charger that is connected to a power source. 

During long-term storage, battery deactivation may tend to occur, which may cause charging to stop early during recharging after 
storage. This issue can be handled by charging and discharging the battery several times. Also, the first charging after prolonged 
storage may yield a lower than normal capacity. While this will vary depending on the storage conditions, charging and 
discharging the battery several times will almost completely restore capacity. 
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4

Using  the  Dolphin 7400/7450 Mobile Computer
Entering Data

To enter data, you may: 

• Use the 35-key, 43-key or 56-key keypads
• Use the input panel to enter typed text, either by using the soft keyboard or other input method.
• Write directly on the screen.
• Draw pictures on the screen.
• Collect images or scan bar code data into data fields
• Use Microsoft ActiveSync to synchronize or copy information from your desktop computer to your device. For more 

information on ActiveSync, see ActiveSync Help on your desktop computer.

Entering Text Using the Input Panel 
HHP recommends using screen protectors for Dolphin 7400/7450 terminals to protect the input panel display; especially for those  
terminals used for applications that require high-volume interfacing with the touch display. Screen protectors will help prevent 
damage to the touch panel display and are easily installed over the display. Screen protectors can be purchased at any major 
computer retail store.

Note: For touch screen input, only use a stylus or your finger. Use of other objects, such as paper clips, pencils, or ink pens can 
damage the input panel and will void the warranty.

Use the input panel to enter information in any program on the Dolphin mobile computer. You can either type using the soft 
keyboard or write using Letter Recognizer, Block Recognizer, or Transcriber. In either case, the characters appear as typed text 
on the screen. 

To show or hide the input panel, tap the Input Panel button. Tap the arrow next to the Input Panel button to see your choices.

When you use the input panel, your terminal anticipates the word you are typing or writing and displays it above the input panel. 
When you tap the displayed word, it is inserted into your text at the insertion point. The more you use your Dolphin 7400/7450 
terminal, the more words it learns to anticipate.

To change word suggestion options, such as the number of words suggested at one time, tap Start> Settings>Personal 
>Input> Word Completion tab.

Input Panel button.

Select an input method.

Tap to see your choices.

Input Panel Button
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Using the Soft Keyboard:
1. Tap the arrow next to the Input Panel button and then Keyboard.

2. On the soft keyboard that is displayed, tap the keys with your stylus.

Input Panel Options

Tap here if this
is the right word.

Soft Keyboard
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Using the Letter Recognizer
With Letter Recognizer you can write letters using the stylus just as you would on paper.

1. Tap the arrow next to the Input Panel button and then Letter Recognizer.

2. Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. For specific instructions on using Letter 
Recognizer, with Letter Recognizer open, tap the question mark next to the writing area.

Using the Block Recognizer:
With Block Recognizer you can input character strokes using the stylus that are similar to those used on other devices.

1. Tap the arrow next to the Input Panel button and then Block Recognizer.

2. Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. For specific instructions on using Block 
Recognizer, with Block Recognizer open, tap the question mark next to the writing area.

Selecting Text
To edit or format typed text, select it by dragging the stylus across the text.

You can cut, copy, and paste text by tapping and holding the selected words and then tapping an editing command on the pop-
up menu, or by tapping the command on the Edit menu.

Letter Recognizer

Block Recognizer
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Writing on the Screen
In any program that accepts writing, such as the Notes program, and in the Notes tab in Calendar, Contacts, and Tasks, you can 
use your stylus to write directly on the screen as you would on paper. You can edit and format what you’ve written and convert 
the information to text at a later time.

To write on the screen, tap the Pen button to switch to writing mode. This action displays lines on the screen to help you write.

Note: Some programs that accept writing may not have the Pen button. See the documentation for that program to find out how 
to switch to writing mode.

To select writing:
If you want to edit or format writing, you must select it first.

1. Tap and hold the stylus next to the text you want to select until the insertion point appears.

2. Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools, then Undo and try again. You can also select text by tapping the Pen button 
to deselect it and then dragging the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with typed text: tap and hold the selected words and then 
tap an editing command on the pop-up menu, or tap the command on the Edit menu.

Tap the Pen button and use
your stylus like a pen.

Writing on the Screen
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Convert Writing to Text:
To use this feature, install Letter Transcriber from the Companion CD.

To convert writing to text, tap Tools and then Recognize.

If you want to convert only certain words, select them before tapping Recognize on the Tools menu (or tap and hold the selected 
words and then tap Recognize on the pop-up menu). If a word is not recognized, it is left as writing.

Select the text you want
to convert and tap Recognize on the
pop-up menu.

The writing is turned into
text.

Writing on the Screen 
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If the conversion is incorrect, you can select different words from a list of alternates or return to the original writing. To do so, tap 
and hold the incorrect word (tap one word at a time). On the pop-up menu, tap Alternates. A menu with a list of alternate words 
appears. Tap the word you want to use, or tap the writing at the top of the menu to return to the original writing.

Tips for Getting Good Recognition
• Write neatly.
• Write on the lines and draw descenders below the line. Write the cross of the “t” and apostrophes below the top line so that 

they are not confused with the word above. Write periods and commas above the line.
• For better recognition, try increasing the zoom level to 300% using the Tools menu.
• Write the letters of a word closely and leave big gaps between words so that the device can easily tell where words begin and 

end.
• Hyphenated words, foreign words that use special characters such as accents, and some punctuation cannot be converted.
• If you add writing to a word to change it (such as changing a “3” to an “8”) after you attempt to recognize the word, the writing 

you add will not be included if you attempt to recognize the writing again. 

Drawing on the Screen

Drawing on the screen is similar to writing on the screen. The difference between writing and drawing on the screen is how you 
select items and how they can be edited. 

To create a drawing, cross three ruled lines on your first stroke. A drawing box appears. Subsequent strokes in or touching the 
drawing box become part of the drawing. Drawings that do not cross three ruled lines will be treated as writing.

For example, selected drawings can be resized, while writing cannot.

Or, tap the word you want
to use.

Tap to return to your
original writing.

Alternate List
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Note: You may want to change the zoom level so that you can more easily work on or view your drawing. Tap Tools and then 
a zoom level.

Selecting a Drawing
To edit or format a drawing, tap and hold the stylus on the drawing until the selection handle appears. To select multiple drawings, 
deselect the Pen button and then drag to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding the selected drawing and then tapping an editing 
command on the pop-up menu, or by tapping the command on the Edit menu. To resize a drawing, make sure the Pen button 
is not selected, and drag a selection handle.

The drawing box indicates
the boundaries of the drawing.

Pen button.

Drawing on the Screen
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Using My Text
When using Inbox or MSN Messenger, use My Text to quickly insert preset or frequently used messages into the text entry area. 
To insert a message, tap My Text and tap a message.

Note: You can add text after inserting a My Text message before sending it.

To edit a My Text message, in the Tools menu, tap Edit and then tap My Text Messages. Select the message you wish to edit 
and make desired changes.

Via the Keyboard
Data can be entered into the Dolphin 7400/7450 terminal via the keyboard. The Dolphin 7400/7450 has three keyboard options:  
43-key alpha/numeric, 35-key numeric/alpha, and 56-key full alpha/numeric.

To enter data, press the appropriate key and the corresponding number or letter appears on the screen. 

See Appendix A for a list of keyboard shortcuts for navigating the keyboard.

Using the Image Reader
Dolphin 7400/7450 terminals are equipped an image reader that reads 1D and 2D bar codes, OCR characters and can capture 
images, such as signatures and gray scale pictures. The imager features either a red or green aiming beam that is used to aim 
the image reader against the bar code or item being read.

The terminal supports two types of image decoding for use in various bar code reading and imaging applications: ALD (Advanced 
Linear Decoding) for fast reading of linear 1D and 2D bar codes, and full area imaging for omni-directional reading of linear and 
non-linear 1D and 2D bar codes, OCR, signature capture, and picture taking.

Tap to select a
prewritten message.

Using My Text
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The decoding method used in a particular scanning or image capture application is determined by the application developer and 
cannot be changed by the end user. The imaging capabilities of both decode methods help simplify terminal operation and 
enhance data capture productivity.

When reading linear 1D and 2D bar codes using ALD, the  imager’s aiming beam should be centered horizontally across the bar 
code to achieve a positive read. 

When reading all bar code types using full area imaging, the aiming beam should be centered horizontally across the bar code 
to achieve the best read, though a positive read can be obtained from most any position. 

Reading A Bar code

1. Press the ON/SCAN button on the 7400 or the Scan Trigger on the 7450  to project the scanner’s bright red or green aiming 
beam. The aiming beam should be oriented in line with the bar code to achieve the quickest read. A range of 4-10 inches 
(10-25 cm) is recommended. 

2. Center the aiming beam over the bar code. The red SCAN LED illuminates when the user presses the ON/KEY key, and the 
green DECODE LED illuminates when a bar code is successfully decoded and the terminal beeps.   

Scan LEDDecode LED
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The aiming beam is smaller when the terminal is held closer to the code and larger when it is farther from the code. Symbologies 
with smaller bars or elements (mil size) should be read closer to the unit. Symbologies with larger bars or elements (mil size) 
should be read farther from the unit.

Capturing Images

The image-capture process is an intuitive, split-second operation for experienced users. By following the basic guidelines, new 
users can easily develop their own technique and, with practice, quickly learn to adapt it to different circumstances. Basic steps 
for acquiring images using the Dolphin 7400/7450 terminal include:

1. To aim, point the display end of the 7400 horizontally at a 45° angle approximately 2 to 9 inches (5 to 20 cm) away from the 
target.  You may have to adjust the angle at which you hold the Dolphin if there is glare on the screen. 

2. Press the ON/SCAN button to take an image. Use the live video image on the terminal screen as a guide for positioning and 
aiming the terminal at the target. You may find it helpful to start by moving the terminal further away and then in closer to 
the target. The active screen image will have a slightly degraded appearance compared to the captured image. This is 
normal.

3. Release the ON/SCAN button to capture the image when the desired image is displayed on the terminal screen.  Hold the 
Dolphin terminal as still as possible when capturing the image. 

Basic steps for acquiring images using the Dolphin 7450 terminal are:

1. Point the display end of the 7450 directly at the target.

2. Pull the Scan Trigger to take the image. Use the live video image on the terminal screen as a guide for positioning and 
aiming the terminal at the target. You may find it helpful to start by moving the terminal further away and then in closer to 
the target. The active screen image will have a slightly degraded appearance compared to the captured image. This is 
normal.

Linear bar code 2D Matrix symbol
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3. Release the Scan Trigger to capture the image when the desired image is displayed on the terminal screenn. Hold the 
Dolphin terminal as still as possible when capturing the image.

The image quality and related file size are determined by the data compression method used by your software application.  For 
highest quality, take grayscale images. When saved, the image will be saved in JPEG file format. The size of  the file depends 
on the information content of the image and will be approximately 4-8 K. 

Communication

Communication Media
Via the RS-232 Port

The industry-standard RS-232 port supplies 5 volts of power and allows the user to connect external devices such as scanners 
and printers, to the Dolphin 7400 and 7450 terminals. 

Via the IrDA Port

The IrDA port allows the Dolphin 7400/7450 to send data via pulses of light to and from other IrDA-compliant devices, such as 
printers and PCs. 

Via the Radio

The Dolphin 7400/7450 RF may be equipped with a  2.4 GHz 802.11b-compliant direct sequence or frequency hopping 

spread spectrum local area network (LAN) radio.

Software Communication Programs
Microsoft® ActiveSync®

In the Dolphin 7400/7450 development environment, Microsoft® ActiveSync® is a tool for developers. It allows Pocket PC 
devices like the 7400/7450 to connect to and exchange data with a desktop computer.

RAS

Short for Remote Access Services, a feature built into Windows NT® that enables users to log into an NT-based LAN using a 
modem, X.25 connection or WAN link. RAS is fully supported and allows the use of PPP or SLIP connections for network 
connectivity.

Using the Keyboard

Using the Special Keys

The Dolphin 7400 and 7450 keyboards have special keys and key combinations that you use to type characters or perform 
functions. See the chart in Appendix A for key combinations for keyboard functions and special characters that use these keys.
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Dolphin 7400/7450 43-Key Front View

ON/Scan Key

Escape Key

Enter Key

Backlight Key

Alt Key

Red Modifier Key

Number Lock 
Key

Shift Key

Cursor Keys

Control Key

Tab Key

Enter Key

Blue Modifier Key
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Using the Cursor Keys
Use the cursor keys to navigate around on an application screen. The use of these keys can vary depending on the application.

Cursor Keys

To Use This Cursor Key              Press Description
Arrow up Moves cursor up one row 

or line.

Arrow down Moves cursor down one 
row or line.

Arrow right Moves cursor one 
character to the right.

Arrow left Moves cursor one 
character to the left.
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Using the Modifier Keys

All three versions of the Dolphin 7400/7450 keyboard feature the standard PC keyboard modifier keys, Alt, Ctl and Shift. For 
single-handed operation, the Shift key only modifies the next key pressed; it must be pressed and released before each key you 
wish to modify. Functions of the Alt and Ctl keys are dependent on the software application in use.

There are two additional modifier keys located on the bottom row of the keyboard. Use these keys in combination with other keys 
to type the corresponding color-coded characters and functions. The Red and Blue keys only modify the next key pressed; these 
keys must be pressed and released before each key you wish to modify to the Blue or Red case. See the chart in Appendix A 
for key combinations for keyboard functions and special characters that use these keys.

Other Special Keys
ON/SCAN Key

The ON/SCAN key “wakes” the terminal from sleep mode. Its position also allows convenient one-handed image-taking and/or 
bar code scanning.  On the 7450 terminal, the ON/SCAN key operates as an On or system wakeup control -- scanning is 
activated with the handle trigger.

Shift (SFT)

The Shift key toggles the keyboard from upper case alphabet mode to lower case alphabet mode and back. Caps Lock may also 
be toggled by pressing the red modifier key followed by the Shift key or by double-tapping the Shift key. When Caps Lock is 
toggled on, the Shift key makes characters lower case; when it is toggled off, the Shift key makes keys upper case.

Enter (ENT)

The Enter key confirms data entry.

Escape (ESC)

The Escape key performs a cancel action. 

Tab

The Tab key moves the cursor to the next tab stop or the next control on a form. 

Backlight

The Backlight key toggles the LCD and keyboard backlights on and off.This key may also be used to put the terminal in suspend 
mode by pressing and holding it for three seconds.

Number Lock (NUM)

This key is included only on the 43-key keyboard option which defaults to alphabetic mode. The Number Lock key toggles 
between the alphabetic and numeric modes. 

Alpha Lock (ALPHA)

This key is included only on the 35-key keyboard option which defaults to numeric mode. The Alpha key toggles between the 
numeric and alphabetic modes. 

Backspace (BKSP)

This key appears on both the 35 and 56-keyboard options. The Backspace key moves the cursor back one space for each time 
the key is pressed. Backspace is a shifted function on the 43-key keyboard version. To delete a single character, press Red key 
+ SP. To delete multiple characters, press Red key + SP and hold down the SP key.

Delete (DEL)

This key appears on both the 35 and 56-keyboard options. The Delete key deletes one character for each time the key is pressed. 
Delete is a shifted function on the 43-key keyboard version.

Modifier Keys
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Key Combinations 
There are some keyboard functions and special characters not defined on the Dolphin 7400 and 7450 keyboards. See the charts 
in Appendix A for the key combinations used to access these functions and special characters on your terminal.

Today Screen

When you turn on your device for the first time each day (or after 4 hours of inactivity), you’ll see the Today screen. You can also 
display it by tapping Start and then Today. On the Today screen, you can see at a glance important information for the day.

Your day at a glance.

Tap to create a new item.

Tap to switch
to a program.

Tap to view notification messages.

Tap to view connection status.

Tap to change date and time.

Tap to open an item.

Tap to change volume or mute all sounds.

Today Screen 
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Following are some of the status icons you may see.

Note: If more notification icons need to be displayed than there is room to display them, the Notification icon, , will display. 
Tap the icon to view all notification icons.

Status Icon Meaning

Turns all sounds on and off 

Backup battery is low 

Main batteries are charging 

Main batteries are low 

Main batteries are very low 

Main batteries are full

Connection is active 

Synchronization is beginning or ending

Synchronization is occurring

Notification that one or more instant 
messages were received

Notification that one or more e-mail 
messages were received
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Selecting Programs

To select a program, tap Start>Programs, then the program name. (You can customize which programs you see on this menu. 
For information, see “Adjusting Settings,” later in this chapter.) 

Note: Some programs have abbreviated labels for check boxes and drop-down menus. To see the full spelling of an abbreviated 
label, tap and hold the stylus on the label. Drag the stylus off the label so that the command is not carried out. 

Start Menu
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Navigation Bar and Command Bar

The navigation bar is located at the top of the screen. It displays the active program and current time, and allows you to switch 
to programs and close screens. 

Use the command bar at the bottom of the screen to perform tasks in programs. The command bar includes menu names, 
buttons, and the Input Panel button. To create a new item in the current program, tap New. To see the name of a button, tap and 
hold the stylus on the button. Drag the stylus off the button so that the command is not carried out.

Pop-up Menus

With pop-up menus, you can quickly choose an action for an item. For example, you can use the pop-up menu in the contact list 
to quickly delete a contact, make a copy of a contact, or send an e-mail message to a contact. The actions in the pop-up menus 
vary from program to program. To access a pop-up menu, tap and hold the stylus on the item name that you want to perform the 
action on. When the menu appears, lift the stylus, and tap the action you want to perform. Or tap anywhere outside the menu to 
close the menu without performing an action.

Tap to select a program.

Tap to change volume or mute the device.

Tap to see additional programs.

Tap to customize the device.

Tap to quickly select a program
you have recently used.

Screen Navigation
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Notifications

Your device reminds you in a variety of ways when you have something to do. For example, if you’ve set up an appointment in 
Calendar, a task with a due date in Tasks, or an alarm in Clock, you’ll be notified in any of the following ways:

• A message box appears on the screen.
• A sound, which you can specify, is played.
• A light flashes on your device. 

To choose reminder types and sounds for your device, tap Start>Settings>Personal tab>Sounds & Notifications. The options 
you choose here apply throughout the device.

Finding and Organizing Information

The Find feature on your Dolphin mobile computer helps you quickly locate information. On the Start menu, tap Find. Enter the 
text you want to find, select a data type, and then tap Go to start the search.

To quickly find information that is taking up storage space on your device, select Larger than 64 KB in Type.

You can also use the File Explorer to find files on your device and to organize these files into folders. On the Start menu, tap 
Programs, and then File Explorer.

You can move files in File Explorer by tapping and holding the item you want to move, and then tapping Cut or Copy and Paste 
on the pop-up menu.

Tap the folder name
to open it.

Tap and hold to create
a new folder.

Select the sort order
for the list.

Tap to change folders.

File Explorer
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5

Dolphin 7400/7450 RF Mobile Computer
The Dolphin® 7400 and 7450 RF terminals integrate the basic functionality of the Batch terminal with a radio frequency interface 
that allows the terminal to communicate with a host computer via a wireless local area network (WLAN).  

Dolphin 7400/7450 terminals have one Type II PCMCIA card slot to allow for an interface with either the Cisco® 2.4 GHz 802.11b 
DSSS WLAN radio or Symbol® Technologies Spectrum24 FHSS 2Mb WLAN radio. 

The Cisco® radio uses direct sequence spread spectrum (DSSS) technology, which spreads its signal continuously over a wide 
frequency band, and provides an Ethernet-like data rate of up to 11 megabits per second. 

The security of wireless networks is greatly enhanced with the use of LEAP (Dynamic WEP), an industry-leading, centralized 
security solution developed by Cisco®. LEAP combines several innovations including dynamic, per user, per-session WEP and 
integrated network logon to promote secure hassle-free enterprise deployment. 

The radio may also provide up to 128-bit Wired Equivalent Privacy (WEP) encryption. WEP is used to encrypt and decrypt data 
signals transmitted between Wireless LAN (WLAN) devices. The optional WEP security mechanism is available with 128-bit or 
40-bit encryption.

Dolphin 7400/7450 RF is interoperable with other 802.11b WiFi®-compliant products such as printers and PCs via PC-card 
adapters.

Refer to Chapters 1 and 2 in this manual for more on basic operation of the Dolphin terminal.
5 - 1



Configuring The Dolphin 7400/7450 RF Terminal

When you cold-boot the Dolphin 7400/7450 RF terminal, the red LED comes on and the green LED blinks, and after 
approximately 3 seconds, the welcome screen shown below will appear.  

Tap the screen or press <Enter> and you will be prompted to calibrate the screen and set the time zone. Refer to the section on 
Calibrating the Screen, Setting the Time Zone in Chapter 2 for additional information. After the wizard is finished, the Dolphin 
demos and Cisco® radio drivers self-install and the main menu for the HHP demos displays.

Client Utilities for the Cisco® DSSS 802.11b Radio
The following utilities are available for configuring the Cisco 802.11b radio:

Client Utility (ACU) - Configures the radio for use in a wireless network

Wireless Login Module (WLM) - Provides login interface to Radius server if using LEAP 

This document covers the basics of the Client Utility (ACU). For more detailed information on these and the other utilities, please 
refer to the document entitled “Using the Client Utilities for Windows CE” included on the Dolphin Documentation CD. 

Dolphin Welcome Wizard
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Configuring the Cisco® DSSS WLAN Radio
The Aironet Client Utility (ACU) enables you to change the configuration parameters of the Cisco DSSS WLAN radio. Exit the 
HHP demo screen. Go to Start>Programs>Cisco. Tap the Client Utility (ACU) icon and the screen shown below displays. 

Aironet Client Utility Screen
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To make changes to Profile0, tap the Edit button and the screen shown below displays.

For more information on the radio settings, open Windows>Cisco  Setup.htm.

Edit Aironet Client Utility Screen
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Configuring the Symbol® Spectrum24® FHSS WLAN Radio
Exit the HHP demo screen to continue with configuring the radio card. Go to Start>Programs>Spectrum24. Double-tap the 
NICTT icon and the screen shown below displays. 

To configure the radio card:

1. Enter the ESSID (wireless LAN identifier) for the network. Note:  The 101 value is the factory default. If  you do not know the 
ESSID, contact your system  administrator. 

2. Click Advanced to customize Mobile Unit, MicroAP, Encryption, and WLAN Adapter options.

3. Click OK to return to the previous menu.

4. Click OK to exit the Spectrum24 Easy Setup Utility.

For more information on specific radio settings, click on Help to access the on-line help file or see the Spectrum24 User’s Guide 
included on the HHP Dolphin Documentation CD.

Spectrum24 Easy Setup
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6

Customizing Your Dolphin 7400/7450
You can customize your Dolphin 7400/7450 mobile by adjusting device settings and installing additional software.

Adjusting Settings

You can adjust device settings to suit the way you work. To see available options, tap Start, Settings, then the Personal or 
System tab located at the bottom of the screen.

You might want to adjust the following:

• Clock, to change the time or to set alarms
• Menus, to customize what appears on the Start menu, and to enable a pop-up menu from the New button
• Owner Information, to enter your contact information
• Password, to limit access to your device
• Power, to maximize battery life
• Today, to customize the look and the information that is displayed on the Today screen

Adding Programs

Programs added to your device at the factory are stored in ROM (read-only memory). You cannot remove this software, and you’ll 
never accidentally lose ROM contents. ROM programs can be updated using special installation programs with a *.xip extension. 
All other programs and data files added to your device after factory installation are stored in RAM (random access memory). 

You can install any program created for your device, as long as your device has enough memory. The most popular place to find 
software for your device is on the Pocket PC Web site (http://www.microsoft.com/mobile/pocketpc).

To add programs using ActiveSync

You’ll need to install the appropriate software for your device on your desktop computer before installing it on your device.

1. Determine your device and processor type so that you know which version of the software to install. Tap Start and then 
Settings. On the System tab, tap About. In the Version tab, make a note of the information in Processor. 

2. Download the program to your desktop computer (or insert the CD or disk that contains the program into your desktop 
computer). You may see a single *.xip,  *.exe,, or *.zip file, a Setup.exe file, or several versions of files for different device 
types and processors. Be sure to select the program designed for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions.

4. Connect your device and desktop computer.

5. Double-click the *.exe file.

If the file is an installer, the installation wizard will begin. Follow the directions on the screen. Once the software has been installed 
on your desktop computer, the installer will automatically transfer the software to your device. 

If the file is not an installer, you will see an error message stating that the program is valid but it is designed for a different type 
of computer. You will need to move this file to your device. If you cannot find any installation instructions for the program in the 
Read Me file or documentation, use ActiveSync Explore to copy the program file to the Program Files folder on your device. For 
more information on copying files using ActiveSync, see ActiveSync Help. 

Once installation is complete, tap Start, Programs, and then the program icon to switch to it.

To add a program directly from the Internet
1. Determine your device and processor type so that you know which version of the software to install. Tap Start  and then Set-

tings. On the System tab, tap About. In the Version tab, make a note of the information in Processor. 

2. Download the program to your device straight from the Internet using Pocket Internet Explorer. You may see a single *.xip,  
*.exe or *.zip file, a Setup.exe file, or several versions of files for different device types and processors. Be sure to select the 
program designed for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions.
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4. Tap the file, such as a *.xip or *.exe file. The installation wizard will begin. Follow the directions on the screen.

Adding a Program to the Start Menu
Tap Start, Settings, Menus, the Start Menu tab, and then the check box for the program. If you do not see the program listed, 
you can either use File Explorer on the device to move the program to the Start Menu folder, or use ActiveSync on the desktop 
computer to create a shortcut to the program and place the shortcut in the Start Menu folder.

Using File Explorer on the Dolphin 7400/7450

1. Tap Start, Programs, File Explorer, and locate the program (tap the folder list, labeled My Documents by default, and then 
My Device to see a list of all folders on the device). 

2. Tap and hold the program and tap Cut on the pop-up menu. 

3. Open the Start Menu folder located in the Windows folder, tap and hold a blank area of the window, and tap Paste on the 
pop-up menu. 

4. The program will now appear on the Start menu.

For more information on using File Explorer, see “Find and Organize Information,” on page .

Using ActiveSync on the desktop computer: Use the Explorer in ActiveSync to explore your device files and locate the 
program. Right-click the program, and then click Create Shortcut. Move the shortcut to the Start Menu folder in the Windows 
folder. The shortcut now appears on the Start menu. For more information, see ActiveSync Help.

Removing Programs
Tap Start and then Settings. On the System tab, tap Remove Programs.

If the program does not appear in the list of installed programs, use File Explorer on your device to locate the program, tap and 
hold the program, and then tap Delete on the pop-up menu.
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7

Applications
Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You can use these programs individually or 
together. For example, e-mail addresses stored in Contacts can be used to address e-mail messages in Inbox. 

Using ActiveSync, you can synchronize information in Microsoft Outlook or Microsoft Exchange on your desktop computer with 
your device. You can also synchronize this information directly with a Microsoft Exchange server. Each time you synchronize, 
ActiveSync compares the changes you made on your device and desktop computer or server and updates both computers with 
the latest information. For information on using ActiveSync, see ActiveSync Help on the desktop computer.

You can switch to any of these programs by tapping them on the  menu.

Calendar: Scheduling Appointments and Meetings

Use Calendar to schedule appointments, including meetings and other events. You can check your appointments in one of 
several views (Agenda, Day, Week, Month, and Year) and easily switch views by using the View menu.

Note: You can customize the Calendar display, such as changing the first day of the week, by tapping Options on the Tools 
menu. 

Tap to go to today.

Tap to display or edit
the appointment details.

Tap to create a new appointment.

Calendar Application
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To create an appointment:

1. If you are in Day or Week view, tap the desired date and time for the appointment.

2. Tap New.

3. Using the input panel, enter a description and a location. Tap first to select the field. 

4. If needed, tap the date and time to change them.

5. Enter other desired information. You will need to hide the input panel to see all available fields.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, 
see “Notes: Capturing Thoughts and Ideas,” later in this chapter.

7. When finished, tap OK to return to the calendar. 

Note: If you select Remind me in an appointment, your device will remind you according to the options set in Start, Settings, 
Personal tab, Sounds & Reminders. 

Tap to select a date.

Tap to select a time.

Tap to return to the calendar
(the appointment is saved
automatically).

Tap to choose from
previously entered locations.

Tap to choose from
predefined text.

Notes is a good place
for maps and directions.

Entering an Appointment
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Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed. To change the appointment, tap Edit.

Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting request will be created 
automatically and sent either when you synchronize Inbox or when you connect to your e-mail server. Indicate how you want 
meeting requests sent by tapping Tools and then Options. If you send and receive e-mail messages through ActiveSync, select 
ActiveSync.

To schedule a meeting:

1. Create an appointment.

2. In the appointment details, hide the input panel, and then tap Attendees.

3. From the list of e-mail addresses you’ve entered in Contacts, select the meeting attendees. 

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see Calendar Help and Inbox Help on the device.

View appointment details.

View.

Tap to change
appointment.

Appointment Summary Screen
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Contacts

Contacts maintains a list of your friends and colleagues so that you can easily find the information you’re looking for, whether 
you’re at home or on the road. Using the device infrared (IR) port, you can quickly share Contacts information with other device 
users.

Note: To change the way information is displayed in the list, tap Tools and then Options.

Tap and enter part of a name to
quickly find it in the list.

Tap to display or edit
the contact details.

Tap and hold to display
a pop-up menu of actions.

Tap to see additional phone
numbers and e-mail addresses.

Tap to create a new contact.

Select the category of contacts
you want displayed in the list.

Contact Application
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To create a contact:

1. Tap New.

2. Using the input panel, enter a name and other contact information. You will need to scroll down to see all available fields.

3. To assign the contact to a category, scroll to and tap Categories and select a category from the list. In the contact list, you 
can display contacts by category.

4. To add notes, tap the Notes tab. You can enter text or draw. For more information on creating notes, see “Notes: Capturing 
Thoughts and Ideas,” later in this chapter.

5. When finished, tap OK to return to the contact list.

There are four ways to find a contact: 

• In the contact list, enter a contact name in the box under the navigation bar. To show all contacts again, clear text from the 
box or tap the button to the right of the box. 

• In the contact list, tap the category list (labeled All Contacts by default) and select the type of contact that you want displayed. 
To show all contacts again, select All Contacts. To view a contact not assigned to a category, select None. 

• To view the names of companies your contacts work for, in the contact list, tap View > By Company. The number of contacts 
that work for that company will be displayed to the right of the company name. 

• Tap Start, Find, enter the contact name, select Contacts for the type, and then tap Go. 

Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed. To change the contact information, tap Edit.

Notes is a good place
for maps and directions.

Tap to return to the contact
list (the contact is saved
automatically).

Scroll to see more fields.

Creating a Contact
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View contact details.

Tap to view notes.

Tap to change contact information.

Contacts Summary Screen
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Tasks

Use Tasks to keep track of what you have to do. 

Note: To change the way information is displayed in the list, tap Tools and then Options.

Tap to create a new  task.

Select the sort order
of the list.

Indicates high priority.

Select the category of tasks
you want displayed in the list.

Tap to display or edit
the task details.

Tap and hold to display
a pop-up menu of actions.

Task Application
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To create a task:

1. Tap New.

2. Using the input panel, enter a description.

3. You can enter a start date and due date or enter other information by first tapping the field. If the input panel is open, you will 
need to hide it to see all available fields.

4. To assign the task to a category, tap Categories and select a category from the list. In the task list, you can display tasks by 
category.

5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, see 
“Notes,” later in this chapter.

6. When finished, tap OK to return to the task list.

Note: To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap Tap here to add a new task 
and enter your task information.

Tap to return to the task
list (the task is saved
automatically).

Tap to choose from
predefined subjects.

Notes is a good place
for maps and drawings.

Creating a Task
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Using the Summary Screen
When you tap a task in the task list, a summary screen is displayed. To change the task, tap Edit.

View task details.

View notes.

Tap to show and hide additional
summary information.

Tap to change task.

Task Summary Screen
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Notes

Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. You can create a written note or a 
recording. 

Tap to open a note or
play a recording.

Tap and hold to display
a pop-up menu of actions.

Tap to create a new  item.

Tap to change the sort
order of the list.

Tap to show or hide the
Recording toolbar.

Tap to record.

Notes Application
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To create a note:

1. Tap New.

2. Create your note by writing, drawing, typing, and recording. 

Inbox

Use Inbox to send and receive e-mail messages in either of these ways: 

• Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop computer.
• Send and receive e-mail messages by connecting directly to an e-mail server through an Internet service provider (ISP) or a 

network.

Synchronizing E-mail Messages
E-mail messages can be synchronized as part of the general synchronization process. You will need to enable Inbox 
synchronization in ActiveSync. For information on enabling Inbox synchronization, see ActiveSync Help on the desktop 
computer.

During synchronization:

• Messages are copied from the mail folders of Exchange or Outlook on your desktop computer to the ActiveSync folder in Inbox 
on your device. By default, you will receive messages from the past three days only, the first 100 lines of each message, and 
file attachments of less than 100 KB in size.

Tap to return to the note
list (the note is saved
automatically).

Tap to write on the screen.

Tap to show or hide
the input panel.

Tap to add a recording
to the note.

Creating a Note
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• E-mail messages in the Outbox folder on your device are transferred to Exchange or Outlook, and then sent from those 
programs.

• E-mail messages in subfolders must be selected in ActiveSync on your desktop computer in order to be transferred.

Note: You can also synchronize e-mail messages with your desktop computer from a remote location. For more information, 
see Chapter 7.

Connecting Directly to an E-mail Server
In addition to synchronizing e-mail messages with your desktop computer, you can send and receive e-mail messages by 
connecting to an e-mail server.

When you connect to the e-mail server, new messages are downloaded to the device Inbox folder, messages in the device 
Outbox folder are sent, and messages that have been deleted on the e-mail server are removed from the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your desktop computer. 
When you delete a message on your device, it is also deleted from the e-mail server the next time you connect based on the 
settings you selected in ActiveSync.

You can work online or offline. When working online, you read and respond to messages while connected to the e-mail server. 
Messages are sent as soon as you tap Send, which saves space on your device.

When working offline, once you’ve downloaded new message headers or partial messages, you can disconnect from the e-mail 
server and then decide which messages to download completely. The next time you connect, Inbox downloads the complete 
messages you’ve marked for retrieval and sends the messages you’ve composed.
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Using the Message List
Messages you receive are displayed in the message list. By default, the most recently received messages are displayed first in 
the list.

When you receive a message, tap it to open it. Unread messages are displayed in bold.

Select the sort order
for messages.

Select the service and folder
you want to display.

Tap to connect to
the selected service.

Tap to connect and to
send and receive e-mail.

Tap to open a message.

Tap and hold to display
a pop-up menu of actions.

InBox Application
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When you connect to your e-mail server or synchronize with your desktop computer, by default, you’ll receive messages from 
the last five days only, the first 100 lines of each new message, and file attachments of less than 100 KB in size. The original 
messages remain on the e-mail server or your desktop computer. 

You can mark the messages that you want to retrieve in full during your next synchronization or e-mail server connection. In the 
message list, tap and hold the message you want to retrieve. On the pop-up menu, tap Mark for Download. The icons in the 
Inbox message list give you visual indications of message status.

You specify your downloading preferences when you set up the service or select your synchronization options. You can change 
them at any time:

• Change options for Inbox synchronization using ActiveSync options. For more information, see ActiveSync Help.
• Change options for direct e-mail server connections in Inbox on your device. Tap Tools and then tap Options. On the Service 

tab, tap the service you want to change. Tap and hold the service and select Delete to remove a service.

Tap to delete this message.

Tap to view  the previous
or next message.

Tap to reply to or
forward this message.

Tap to return to
the message list.

Viewing A Message
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Composing Messages

To compose a message:

1. Tap New. 

2. In the To field, enter an e-mail or SMS address of one or more recipients, separating them with a semicolon, or select a 
name from the contact list by tapping the Address Book button. 
All e-mail addresses entered in the e-mail fields in Contacts appear in the Address Book.

• Compose your message. To enter preset or frequently used messages, tap My Text and select a message.
• Tap Send when you’ve finished the message. If you are working offline, the message is moved to the Outbox folder and will 

be sent the next time you connect.

If you are sending an SMS message and want to know if it was received, tap Edit, Options, and select Request SMS text 
message delivery notification before sending the message.

Tap to show or hide
the complete header.

Tap to send the message.

Tap to insert common messages.

Tap to show / hide the
recording toolbar.

Tap to display the Address Book.

Creating a Message
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Managing E-mail Messages and Folders
By default, messages are displayed in one of five folders for each service you have created: Inbox, Deleted Items, Drafts, Outbox, 
and Sent Items. The Deleted Items folder contains messages that have been deleted on the device. The behavior of the Deleted 
and Sent Items folders depends on the options you have chosen. In the message list, tap Tools and then Options. On the 
Message tab, select your options.

If you want to organize messages into additional folders, tap Tools, and then Manage Folders to create new folders. To move 
a message to another folder, in the message list, tap and hold the message and then tap Move to on the pop-up menu.

Folder behavior with a direct connection to an e-mail server

The behavior of the folders you create depends on whether you are using ActiveSync, SMS, POP3, or IMAP4. 

• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will automatically be synchronized with your device. 
You can select to synchronize additional folders by designating them for ActiveSync. The folders you create and the 
messages you move will then be mirrored on the server. For example, if you move two messages from the Inbox folder to a 
folder named Family, and you have designated Family for synchronization, the server creates a copy of the Family folder and 
copies the messages into that folder. You can then read the messages while away from your desktop computer.

• If you use SMS, messages are stored in the Inbox folder. 
• If you use POP3 and you move e-mail messages to a folder you created, the link is broken between the messages on the 

device and their copies on the mail server. The next time you connect, the mail server will see that the messages are missing 
from the device Inbox and delete them from the server. This prevents you from having duplicate copies of a message, but it 
also means that you will no longer have access to messages that you move to folders created from anywhere except the 
device. 

• If you use IMAP4, the folders you create and the e-mail messages you move are mirrored on the server. Therefore, messages are available 
to you anytime you connect to your mail server, whether it is from your device or desktop computer. This synchronization of folders occurs 
whenever you connect to your mail server, create new folders, or rename/delete folders when connected. 
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Communications
Using Microsoft ActiveSync, you can synchronize the information on your desktop computer with the information on your 
device. Synchronization compares the data on your Dolphin mobile computer with your desktop computer and updates both 
computers with the most recent information. For example:

• Keep Pocket Outlook data up-to-date by synchronizing your device with Microsoft Outlook data on your desktop computer. 
• Synchronize Microsoft Word and Microsoft Excel files between your device and desktop computer. Your files are automatically 

converted to the correct format

Note: By default, ActiveSync does not automatically synchronize all types of information. Use ActiveSync options to turn 
synchronization on and off for specific information types.

With ActiveSync, you can also:

• Back up and restore your device data. 
• Copy (rather than synchronize) files between your device and desktop computer. 
• Control when synchronization occurs by selecting a synchronization mode. For example, you can synchronize continually 

while connected to your desktop computer or only when you choose the synchronize command.
• Select which information types are synchronized and control how much data is synchronized. For example, you can choose 

how many weeks of past appointments you want synchronized.

Before you begin synchronization, install ActiveSync on your desktop computer from the Pocket PC Companion CD. ActiveSync 
is already installed on your device. 

To install ActiveSync on your desktop computer, insert the Pocket PC Companion CD into the CD-ROM drive of your desktop 
computer. Click the yellow arrow, click Start Here, and then follow the directions on your screen.

After installation is complete, the ActiveSync Setup Wizard helps you connect your device to your desktop computer, set up a 
partnership so you can synchronize information between your device and your desktop computer, and customize your 
synchronization settings. Your first synchronization process will automatically begin when you finish using the wizard. ActiveSync 
is already installed on your device.

After installation is complete, the ActiveSync Setup Wizard helps you connect your device to your desktop computer, set up a 
partnership so you can synchronize information between your device and your desktop computer, and customize your 
synchronization settings. Your first synchronization process will automatically begin when you finish using the wizard. 

After your first synchronization, take a look at Calendar, Contacts, and Tasks on your device. You’ll notice that information you’ve 
stored in Microsoft Outlook on your desktop computer has been copied to your device, and you didn’t have to type a word. 
Disconnect your device from your computer and you’re ready to go!

Once you have set up ActiveSync and completed the first synchronization process, you can initiate synchronization from your 
device. 

To switch to ActiveSync on your device, tap Start, and then tap ActiveSync. Note that if you have a wireless LAN card, you can 
synchronize remotely from your device.

For information about using ActiveSync on your desktop computer, start ActiveSync on your desktop computer, and then see 
ActiveSync Help.
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For more information about ActiveSync on your device, switch to ActiveSync, tap Start, and then tap Help.

Tap to connect and synchronize.

View synchronization status.

Tap to synchronize via IR or
change synchronization settings.

View connection status.

Tap to stop synchronization.

ActiveSync
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Getting Connected
THIS INFORMATION IS INCLUDED IN MERLIN DOCUMENT FROM MICROSOFT. WHAT, IF ANYTHING, IN THIS CHAPTER 
APPLIES TO THE 7400 AND SHOULD BE INCLUDED??????

You can use your device to exchange information with other mobile devices as well as your desktop computer, a network, or the 
Internet. You have the following connection options:

• Use the infrared (IR) port on your device to send and receive files between two devices. If this is the method you want to use, 
see the following section “Transfer Items Using Infrared.”

• Connect to your Internet service provider (ISP). Once connected, you can send and receive e-mail messages by using Inbox 
and view Web or WAP pages by using Microsoft Pocket Internet Explorer. The communication software for creating an ISP 
connection is already installed on your device. Your service provider will provide software needed to install other services, 
such as paging and fax services.

• Connect to your desktop computer to synchronize remotely. Once connected, you can synchronize information such as your 
Pocket Outlook information. If this is the method you want to use, see ActiveSync Help on your desktop computer or 
Connections Help on the device.

Transfer Items Using Infrared

Using infrared (IR), you can send and receive information, such as contacts and appointments, between two Windows-equipped 
devices.

To send information:

1. Open the program where you created the item you want to send and locate the item in the list.

2. Align the IR ports so that they are unobstructed and within a close range.

3. Tap and hold the item, and tap Beam Item on the pop-up menu.

Note: You can also send items, but not folders, from File Explorer. Tap and hold the item you want to send, and then tap Beam 
File on the pop-up menu.

To receive information:

1. Align the IR ports so that they are unobstructed and within a close range.

2. Have the owner of the other device send the information to you. Your device will automatically receive it.

Note: For IR receive to work automatically, you must first check th Receive all incoming beams and select discoverable mode 
checkbox in Start>Settings>Connections>Beam. If this box is not checked, select Start>Programs>Infrared Receive 
before receiving data from another device.

Get Help on Connecting

More information on the procedures described here, as well as information on additional procedures, can be found in the following 
locations:

• “Inbox: Sending and Receiving E-mail Messages” in Chapter 4.
• Online Help on the device. Tap Start and then Help. Tap View, All Installed Help, and then Inbox or Connections.
• ActiveSync Help on the desktop computer. In ActiveSync, click Microsoft ActiveSync Help on the Help menu.

For troubleshooting information, go to the Pocket PC Web site at: http://www.microsoft.com/mobile/pocketpc
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Pocket Internet Explorer 
Use Microsoft Pocket Internet Explorer to view Web or WAP pages in either of these ways:

• During synchronization with your desktop computer, download your favorite links and mobile favorites that are stored in the 
Mobile Favorites subfolder in Internet Explorer on the desktop computer.

• Connect to an Internet service provider (ISP) or network and browse the Web. 

When connected to an ISP or network, you can also download files and programs from the Internet or intranet.

To switch to Pocket Internet Explorer, tap Start and then Internet Explorer.

The Mobile Favorites Folder

Only items stored in the Mobile Favorites subfolder in the Favorites folder in Internet Explorer on your desktop computer will be 
synchronized with your device. This folder was created automatically when you installed ActiveSync. 

Favorite Links
During synchronization, the list of favorite links in the Mobile Favorites folder on your desktop computer is synchronized with 
Pocket Internet Explorer on your device. Both computers are updated with changes made to either list each time you synchronize. 
Unless you mark the favorite link as a mobile favorite, only the link will be downloaded to your device, and you will need to connect 
to your ISP or network to view the content. For more information on synchronization, see ActiveSync Help on the desktop 
computer.

Mobile Favorites 
If you are using Microsoft Internet Explorer 5.0 or later on your desktop computer, you can download mobile favorites to your 
device. Synchronizing mobile favorites downloads Web content to your device so that you can view pages while you are 
disconnected from your ISP and desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites:

1. In Internet Explorer on your desktop computer, click Tools and then Create Mobile Favorite.

2. To change the link name, enter a new name in the Name box. 

3. Optionally, in Update, select a desired update schedule.

4. Click OK. Internet Explorer downloads the latest version of the page to your desktop computer.

5. If you want to download the pages that are linked to the mobile favorite you just created, in Internet Explorer on the desktop 
computer, right-click the mobile favorite and then click Properties. In the Download tab, specify the number of links deep 
you want to download. To conserve device memory, go only one level deep.

6. Synchronize your device and desktop computer. Mobile favorites that are stored in the Mobile Favorites folder in Internet 
Explorer are downloaded to your device.

If you did not specify an update schedule in step 3, you will need to manually download content to keep the information updated 
on your desktop computer and device. Before synchronizing with your device, in Internet Explorer on your desktop computer, 
click Tools and then Synchronize. You will see the last time content was downloaded to the desktop computer, and you can 
manually download content if needed.

You can add a button to the Internet Explorer toolbar for creating mobile favorites. In Internet Explorer on your desktop computer, 
click View, Toolbars, and then Customize.

Saving Memory on you Dolphin Mobile Computer
Mobile favorites take up storage memory on your device. To minimize the amount of memory used:

• In the settings for the Favorites information type in ActiveSync options, turn off pictures and sounds, or stop some mobile 
favorites from being downloaded to the device. For more information, see ActiveSync Help.

• Limit the number of downloaded linked pages. In Internet Explorer on the desktop computer, right-click the mobile favorite you 
want to change and then Properties. In the Download tab, specify 0 or 1 for the number of linked pages you want to 
download.
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Using AvantGo Channels

AvantGo is a free interactive service that gives you access to personalized content and thousands of popular Web sites. You 
subscribe to AvantGo channels directly from your device. Then, you synchronize your device and desktop computer, or connect 
to the Internet to download the content. For more information, visit the AvantGo Web site.

To sign up for AvantGo: 

1. In ActiveSync options on the desktop computer, turn on synchronization for the AvantGo information type.

2. In Pocket Internet Explorer on your device, tap the Favorites button to display your list of favorites.

3. Tap the AvantGo Channels link.

4. Tap the Activate button.

5. Follow the directions on the screen. You will need to synchronize your device with your desktop computer and then tap the 
My Channels button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list of favorites to see a few of the most popular 
channels. To add or remove channels, tap the Add or Remove link.

Using Pocket Internet Explorer

You can use Pocket Internet Explorer to browse mobile favorites and channels that have been downloaded to your device without 
connecting to the Internet. You can also connect to the Internet through an ISP or a network connection and browse the Web.

Pocket Internet Explorer
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To view mobile favorites and channels:

1. Tap the Favorites button to display your list of favorites. 

2. Tap the page you want to view. 

You’ll see the page that was downloaded the last time you synchronized with your desktop computer. If the page is not on your 
device, the favorite will be dimmed. You will need to synchronize with your desktop computer again to download the page to your 
device, or connect to the Internet to view the page.

To browse the Internet:

1. Set up a connection to your ISP or corporate network using Connections, as described in Chapter 9.

2. To connect and start browsing, do one of the following:

• Tap the Favorites button, and then tap the favorite you want to view.
• Tap View and then Address Bar. In the address bar that appears at the top of the screen, enter the Web address you want 

to visit and then tap Go. Tap the arrow to choose from previously entered addresses.

Note: If you select Pocket Internet Explorer before setting up the network connections, a screen may appear allowing you to 
proceed to the connection settings screen. After you select the settings, you return to Pocket Internet Explorer. To add a 
favorite link while using the device, go to the page you want to add, tap and hold on the page, and tap Add to Favorites.

Tap to add or delete
a folder or favorite link.

Tap the favorite you
want to view.

Mobile Favorites
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Companion Programs
The companion programs consist of Microsoft Pocket Word, Microsoft Pocket Excel, and Microsoft Money. 

To switch to a companion program on your device, tap Programs on the Start menu, and then tap the program name.

Pocket Word

Pocket Word works with Microsoft Word on your desktop computer to give you easy access to copies of your documents. You 
can create new documents on your device, or you can copy documents from your desktop computer to your device. Synchronize 
documents between your desktop computer and your device so that you have the most up-to-date content in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports. To create a new file, tap Start> 
Programs>Pocket Word>New. A blank document appears. Or, if you’ve selected a template for new documents in the Options 
dialog box, that template appears with appropriate text and formatting already provided. You can open only one document at a 
time; when you open a second document, you’ll be asked to save the first. You can save a document you create or edit in a 
variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt). 

Pocket Word contains a list of the files stored on your device. Tap a file in the list to open it. To delete, make copies of, and send 
files, tap and hold a file in the list. Then, select the appropriate action on the pop-up menu.

You can enter information in Pocket Word in one of four modes (typing, writing, drawing, and recording), which are displayed on 
the View menu. Each mode has its own toolbar, which you can show and hide by tapping the Show/Hide Toolbar button on the 
command bar.

Tap to change the sort
order of the list.

Tap to open a document.

Tap and hold an item to see
a pop-up menu of actions.

Tap to create a new document.

Select the type of folder you
want displayed in the list.

Using Pocket Word
11 - 1



You can change the zoom magnification by tapping View and then Zoom. Then select the percentage you want. Select a higher 
percentage to enter text and a lower one to see more of your document.

If you’re opening a Word document created on a desktop computer, select Wrap to Window on the View menu so that you can 
see the entire document.

Typing Mode
Using the input panel, enter typed text into the document. For more information on entering typed text, see Chapter 2.

To format existing text and to edit text, first select the text. You can select text as you do in a Word document, using your stylus 
instead of the mouse to drag through the text you want to select. You can search a document to find text by tapping Edit and 
then Find/Replace.

Tap to change
formatting options.

Tap to format text.

Tap and hold to see a
pop-up menu of actions.

Tap to show or hide
the toolbar.

Tap to return to the
document list (changes are
saved automatically).

Formatting Text 
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as a guide, and the zoom magnification 
is greater than in typing mode to allow you to write more easily. For more information on writing and selecting writing, see Chapter 
xx.

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and can be edited and manipulated as 
described in the following section.

Written words are converted to graphics (metafiles) when a Pocket Word document is converted to a Word document on your 
desktop computer.

Drawing Mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. When you lift your stylus off the screen 
after the first stroke, you’ll see a drawing box indicating the boundaries of the drawing. Every subsequent stroke within or touching 
the drawing box becomes part of the drawing. For more information on drawing and selecting drawings, see Chapter xx.

With Space button selected,
drag to insert space. An arrow
appears showing the space
direction and size.

Tap to highlight selected text.

Space button.

Tap to select formatting options,
such as pen weight and line color.

Pen button.

Writing on the Screen in Pocket Word
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For more information on using Pocket Word, tap Start and then Help.

Pocket Excel

Pocket Excel works with Microsoft Excel on your desktop computer to give you easy access to copies of your workbooks. You 
can create new workbooks on your device, or you can copy workbooks from your desktop computer to your device. Synchronize 
workbooks between your desktop computer and your device so that you have the most up-to-date content in both locations.

Use Pocket Excel to create workbooks, such as expense reports and mileage logs. To create a new file, tap Start, Programs, 
Pocket Excel, and then New. A blank workbook appears. Or, if you’ve selected a template for new workbooks in the Options 
dialog box, that template appears with appropriate text and formatting already provided. You can open only one workbook at a 
time; when you open a second workbook, you’ll be asked to save the first. You can save a workbook you create or edit in a variety 
of formats, including Pocket Excel (.pxl) and Excel (.xls).

Pocket Excel contains a list of the files stored on your device. Tap a file in the list to open it. To delete, make copies of, and send 
files, tap and hold a file in the list. Then select the appropriate action from the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and filtering. To display the toolbar, 
tap View and then Toolbar. 

Select Shape on the
pop-up menu to convert
objects to proper shapes.

Resize an object by dragging
the selection handles.

Tap an arrow  to
see your choices.

Tap to select formatting options,
such as line weight, fill color, and line color.

Pen button.

Drawing on the Screen in Pocket Word
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If your workbook contains sensitive information, you can protect it with a password. To do so, open the workbook, tap Edit, and 
then Password. Every time you open the workbook, you will need to enter the password, so choose one that is easy for you to 
remember but hard for others to guess.

Tips for Working in Pocket Excel

When working in large worksheets in Pocket Excel:

• View in full-screen mode to see as much of your worksheet as possible. Tap View and then Full Screen. To exit full-screen 
mode, tap Restore.

• Show and hide window elements. Tap View and then tap the elements you want to show or hide.
• Freeze panes on a worksheet. First select the cell where you want to freeze panes. Tap View and then Freeze Panes. You 

might want to freeze the top and leftmost panes in a worksheet to keep row and column labels visible as you scroll through a 
sheet.

• Split panes to view different areas of a large worksheet. Tap View and then Split. Then drag the split bar to where you want 
it. To remove the split, tap View and then Remove Split.

• Show and hide rows and columns. To hide a hidden row or column, select a cell in the row or column you want to hide. Then 
tap Format, then Row or Column, and then Hide. To show a hidden row or column, tap Tools, then Go To, and then type a 
reference that is in the hidden row or column. Then tap Format, then Row or Column, and then Unhide.

For more information on using Pocket Excel, tap Start and then Help.

Media Player, MSN Messenger, Microsoft Reader are NOT included on the Dolphin 7400/7450 by default but maybe installed 
from the Microsoft Companion CD

Cell contents appear here
as you enter them.

AutoSum button.

Format button.

Zoom button.

Using Pocket Excel
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Dolphin Charging/Communication Cradles
Hub of the System

As the hub of your Dolphin system, Dolphin Charging/Communication cradles perform three important functions – power 
conditioning, communications and storage. Three versions of the charging/communications cradle are available:

• IntelliBase for communicating with devices such as printers and modems without integrated IrDA protocol software
• IntelliBase+ for communicating with devices without integrated IrDA protocol software and charging and conditioning a spare 

battery
• USB HomeBase for communicating directly with a USB-compatible host computer 

Power Conditioning
Dolphin charging/communication cradles provide power to the intelligent battery charging system incorporated into Dolphin 
terminals.

The IntelliBase+ has an auxiliary battery well, located on the back of the cradle, allowing users to charge and condition a spare 
battery.

Ir/IrDA Optical Communications

The infrared, or Ir communications port, on the IntelliBase and IntelliBase+ connects with the IrDA port on the Dolphin terminal.  
With no pins or contacts to break, Ir will work reliably for years. Reliable data communications at speeds of up to 115k baud can 
be transmitted by the IntelliBase and IntelliBase+; data transmission rates with the USB HomeBase up to 4Mbps are possible 
but, at this time, are limited to 115 kbps as the Dolphin 7400 does not currently support 4 Mbps data transfer.  

The IntelliBase and IntelliBase+ infrared connection to the terminal uses IrDA-compliant hardware and software for a reliable 
connection. Communications between the IntelliBase and other devices occur at half duplex serial mode. Half duplex refers to 
the transmission of data in just one direction at a time. 

The USB HomeBase enables direct communication with USB-compatible host computers at rates of up 115 kbps. The USB 
HomeBase also is IrDA 1.3 compliant.

These peripherals cannot be “daisy-chained” but can be networked together using a serial or USB hub.

Convenient Storage 
Dolphin charging/communication peripherals provide a safe and convenient storage receptacle for your Dolphin terminal.  
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Dolphin Charging/Communication Cradle Parts & Functions

Front Panel

IntelliBase/USB HomeBase 

Dolphin Terminal Well  Place the Dolphin in this well to communicate with a host device and to charge the Dolphin’s battery.

LEDs  There are two LEDs on the front panel of the IntelliBase/USB HomeBase.

1. Dock LED   Turns solid green when the Dolphin terminal is properly seated into the Dolphin IntelliBase.

2. COMM LED   Indicates the status of data transfer between the Host Device and the Dolphin Terminal as described below:

Front View of IntelliBase/USB HomeBase

Comm LED Description

Red LED Data is being sent from the Host Device to the 
Dolphin IntelliBase.  

Green LED Data is being sent from the Dolphin IntelliBase to 
the Host Device.

Orange LED Data is being sent at high data rates.

DOCK LED
COMM LED

Terminal Well
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IntelliBase+

Dolphin Terminal Well  Place the Dolphin in this well to communicate with a host device and to charge the Dolphin’s battery.

LEDs  There are three LEDs on the front panel of the IntelliBase+.

Front View of IntelliBase+ 

Terminal Well

DOCK LED AUX BATTERY 
LED

COMM LED
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1. Dock LED   Turns solid green when the Dolphin Terminal is properly seated into the Dolphin IntelliBase.

2. AUX Battery  Indicates charging/calibration status of battery as described below:

3. COMM LED   Indicates the status of data transfer between the Host Device and the Dolphin Terminal as described below:

AUX Battery LED Description

Orange LED Solid indicates that battery pack is being 
charged. Flashing indicates battery is being 
conditioned.  

Red LED Indicates faulty battery.
Green LED Indicates battery charged and ready for use

Comm LED Description

Red LED Data is being sent from the Host Device to  
IntelliBase+.  

Green LED Data is being sent from the IntelliBase+ to the 
Host Device.

Orange LED Data is being sent at high data rates.
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Back Panel

IntelliBase

There is a 5V DC power supply connector and an RS-232 connector:

Power supply connector  Use this connector to attach a power supply to the IntelliBase.  The power supply provides 5V DC 
input for communications and battery charging.

RS-232 Communications Port  Use a standard serial cable to connect this port to a host RS-232 device. 

Rear View of Dolphin IntelliBase

Power Supply 
Connector

RS-232 
Connector
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IntelliBase+

Power supply connector  Use this connector to attach a power supply to the IntelliBase.  The power supply provides 5V DC 
input for communications and battery charging.

RS-232 Communications Port  Use a standard serial cable to connect this port to a host RS-232 device. 

Auxiliary Battery Well  Insert a battery into the well to charge or condition and calibrate a battery pack.

Condition Button  Press and release the button to service the battery in the auxiliary battery well.  

Rear View of Dolphin IntelliBase+

Power Supply 
Connector

RS-232 
Connector

Auxiliary 
Battery Well

Condition Button
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USB HomeBase

There is a 5V DC power supply connector and a USB connector:

Power supply connector  Use this connector to attach a power supply to the USB HomeBase.  The power supply provides 5V 
DC input for communications and battery charging.

USB Communications Port  Use a USB full-speed detachable cable to connect this downstream device port to an upstream 
USB Host or Hub. The USB HomeBase is USB 1.3 compliant.

Bottom Panel of IntelliBase
A Baud Rate switch used to select the communication baud rate is located on the bottom of the IntelliBase. The Baud Rate Switch 
on the IntelliBase is a four-position switch. Switch position and the corresponding baud rates are shown in the charts below. 

The USB HomeBase does not require a baud rate switch.

Rear View of Dolphin USB HomeBase

Power Supply 
Connector

USB Connector
12 - 7



Bottom View of IntelliBase/IntelliBase+

Table 2: IntelliBase/IntelliBase+ Switch Settings

Powering the Dolphin Terminal

Dolphin charging/communication cradles provide power to the intelligent battery charging system incorporated into Dolphin 
terminals. This charging method protects the battery from being damaged by overcharging.  Therefore, Dolphin terminals may 
be stored indefinitely in the charging/communication cradles without damage to the terminals, battery packs, or peripherals.

To charge a Dolphin terminal, follow these steps:

Baud Rate Switch 1 Switch 2 Switch 3 Switch 4

115200 OFF ON ON N/A

57600 ON OFF OFF N/A

38400 ON OFF ON N/A

19200 ON ON OFF N/A

9600 ON ON ON N/A

Baud Rate 
Switch
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1. Insert a battery pack into the Dolphin terminal.

2. Place the terminal, imager/laser engine window up and the LCD visible, in the terminal well of the cradle.  

3. Let it glide down into the well until it stops.  

4. Once the Dolphin terminal is properly seated, the Dock LED on the front of the cradle will be solid GREEN.

Charging Additional Battery Packs in the IntelliBase+
The auxiliary battery well located on the back of the IntelliBase+ allows users to charge and condition a spare battery. Charging 
a Dolphin terminal and a spare battery pack can be done simultaneously as the charging slots work independently to control 
charging and conditioning of the individual batteries. The IntelliBase+ senses when a battery pack is fully charged and 
automatically switches to trickle charge to maintain the battery at full capacity indefinitely.

To charge a spare battery in the IntelliBase+, insert the end of the battery without the locking tab into the bottom of the auxiliary 
well opening and snap the battery into place with a hinging motion. Once the battery is inserted, you can use the AUX BATTERY 
LED to monitor the charging progress.  

Deep-Cycling Batteries
For maximum battery life, HHP recommends that you deep-cycle (service) the battery twice before initial use and then once a 
month thereafter.

The IntelliBase+ is the only Dolphin charging/communication cradle with deep cycling capabilities. Since the Dolphin IntelliBase 
and USB HomeBase do not have deep-cycling capabilities, it is recommended that you use the Battery Conditioning Utility 
software when using those peripherals or use the Dolphin Quad Battery Charger. 

To deep-cycle a battery using the IntelliBase+, insert the battery into the auxiliary battery well. Then, press and release the 
Condition button. The deep-cycling process takes 8-12 hours depending on the battery’s capacity or state of charge.

See the Battery Management section in Chapter 3 for more information.

Setting Up For Communications

The IntelliBase, and IntelliBase+ support RS-232 communications through the RS-232 Communications Port located on the back 
of the device. The IntelliBase translates the RS-232 signals from the host computer into infrared signals to communicate with the 
Dolphin Terminal.

The IntelliBase RS-232 interface allows the Dolphin terminal to communicate to a personal computer, modem, or any standard 
RS-232 device using a standard serial cable and communications software.

IntelliBase/IntelliBase+

The IrDA 1.0 software stack is integrated into the IntelliBase and IntelliBase+ cradles to allow communication between the cradle 
and devices such as modems or printers that are not IrDA ready or do not communicate with a half duplex serial protocol. This 
allows any full or half duplex RS-232 device to communicate through the IntelliBase/IntelliBase+ with no IrDA protocol software. 
See Table 2 for the baud rate switch settings.

Installing The Charging/Communication Cradle
To install and use the IntelliBase or IntelliBase+, you need the following equipment:

• IntelliBase/IntelliBase+ with power supply
• Serial cable

Set the Dolphin IntelliBase/IntelliBase+ on a dry, stable surface, such as a desktop near an electrical outlet.  Be sure to provide 
enough workspace with good lighting for the user to view and operate the Dolphin terminal while it is in the IntelliBase.

Connecting the Cables

Connect the IntelliBase/IntelliBase+ to the host computer or other device by plugging an RS-232 serial cable into the RS-232 
Communications Port on the rear of the IntelliBase. The wiring of your cable depends on whether the other device is set up as a 
DCE (Data Communications Equipment) or DTE (Data Terminal Equipment) device. 

The IntelliBase Communication Port is configured as a DCE device. To communicate with a DTE device such as a computer, 
use a standard (or straight-through) RS-232 cable. To communicate with a DCE device, use either a null modem adapter in line 
with a standard RS-232 cable, or a null-modem serial cable. 

You can make your own cables by following the pin configuration in the chart below.  To do so, you must determine if your host 
RS-232 device is 9-pin or 25-pin, and whether it is configured as a DCE or DTE device.
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The IntelliBase/IntelliBase+ cannot be daisy-chained. 

Connect the power supply to the charging/communication cradle.  Plug the AC transformer into the Dolphin IntelliBase/
IntelliBase+ 5 Volt DC power supply connector.  The AC wall transformer provided can power only one IntelliBase/IntelliBase+.  
HHP recommends that you leave the Dolphin IntelliBase/IntelliBase+ connected to its power source at all times, so that it is 
always ready to use.

Set the baud rate switch to the communication mode you are going to use. Refer toTable 3 for IntelliBase/IntelliBase+ switch 
settings. 

IntelliBase /Host 
Port (DCE)

IBM AT DB9 
(DTE)

IBM XT 
DB25 (DTE)

Modem DB25 
(DCE)

Pin /  Input Signal

2   /  (RD) 2 3 2

3   /  (TD) 3 2 3

5   /  (SG) 5 7 7

4   /  (DTR) 4 20 6

6   /  (DSR) 6 6 20

7   /  (RTS) 7 4 5

8   /   (CTS) 8 5 4
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Configuring the Dolphin Terminal for Communications
The Dolphin terminal may be configured for communications using the Detectoid Communication Utility as described in Chapter 
2 or, manually as described below.

To set Communications Properties:

1. Select Start>ActiveSync>Tools>Options. 

2. Select the PC Connection tab.

3. Select  the desired option for connecting to the desktop computer. Click OK.

4. Place the Dolphin in the cradle.

5. On the Dolphin 7400/7450 desktop, double-tap on ActiveSync.

6. In the ActiveSync connection settings, add check mark to "Allow serial cable or infrared connection to this COM port" and 
select "Infrared Port (IR)" for the COM port as shown below. 

Communications Properties
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To configure the Dolphin 7400/7450 terminal for communications, see the previous section on Configuring the Dolphin 
Terminal. 

Setting Up For Communications With The USB HomeBase

To use the USB HomeBase, you need the following equipment:

• USB HomeBase with power supply
• USB Cable
• CD with USB-IrDA drivers
• Windows® 98, Windows® Me or Windows® 2000 computer.

Note: The USB HomeBase does not support Windows NT®  

To install the USB HomeBase, follow these steps:

1. Plug in the power supply and connect it to the back of the USB HomeBase. 

2. Plug the USB cable into the back of the USB home base.

3. Plug the other end of the USB cable into your PC.

At this point, a dialog box appears on your PC instructing you that the system has detected new hardware and it is searching for 
the HHP USB-IrDA driver.  Unless you have previously installed the USB HomeBase, the OS will be unable to find one and the 
Found New Hardware Wizard screen shown below will display on your PC’s screen.  

ActiveSync Connection Settings
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In the "Locate Drive Files" dialog, check the CD-ROM drives check box and insert the driver CD provided into the CD tray on 
your PC. There are sub-directories in this directory for each type of Windows OS supported.  Select stirusb.sys file in the correct 
sub-directory for your PC:

• w2k  - Windows® 2000
• win98 - Windows® 98
• winme - Windows® Me

At this point, the hardware is installed and operating.  You may need to reset your PC to complete the installation process.  You 
can verify that the USB driver is functioning by watching the COMM LED on the USB home base.  It should be flashing red 
approximately every three seconds.

Once the USB HomeBase is installed, you can use ActiveSync to connect to a Dolphin 7400. These instructions assume that 
ActiveSync v3.1 is installed on your PC.

In the ActiveSync connection settings, add check mark to "Allow serial cable or infrared connection to this COM port" and select 
"Infrared Port (IR)" for the COM port as shown below.  Do not check "Allow USB connection with this desktop computer".  It has 
no effect for the USB HomeBase.
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To configure the Dolphin 7400/7450 terminal for communications, see the previous section on Configuring the Dolphin 
Terminal. 

Communicating with the Dolphin Terminal

To communicate with the Dolphin and any other devices connected to the Dolphin Charging/Communication cradle:

1. Insert the Dolphin into the terminal well of the IntelliBase/USB HomeBase.  If the Dolphin is in sleep mode, it will awaken into 
active state.

2. The DOCK LED on the cradle will illuminate.  If the Dolphin does not turn on, or the LED does not light up, make sure that it 
is properly seated in the terminal well and that the power supply is properly connected to the cradle and plugged into a 
functioning AC outlet.

3. Start your application on the Dolphin terminal or the host computer.  Data can then begin transmitting between the terminal 
and the devices connected to the Dolphin cradle. 

When data transfer begins, the COMM LED on the cradle will blink red and green.  If the IntelliBase/HomeBase will not 
communicate with the Dolphin, check the port connections to ensure that the cradle is correctly configured.  

ActiveSync Connection Settings
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Mounting the IntelliBase/USB HomeBase

The IntelliBase and USB HomeBase may be desk or wall-mounted for convenience and storage. The IntelliBase+ may be desk-
mounted as long as room is allowed for accessibility to the auxiliary battery well.

Desk Mounting:

Dolphin charging/communication cradles have a DIN rail (7.5 X 35 mm) slot on the bottom to allow for secure desk attachment 
of the unit if desired.

Wall Mounting:

The IntelliBase/USB HomeBase also has two DIN rail (7.5 X 35mm) slots on the back to allow for secure wall mounting of the 
unit if desired. The IntelliBase+ may not be wall-mounted. 
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When using right-angle style RS-232 connector cable, the DIN rails may be mounted directly to the wall.  When using standard 
RS-232 connector cables, it is recommended that the rails be mounted to the wall using a 25mm (1 in.) spacer to allow for 
appropriate strain relief of the cables.  

In either case, after wall mounting, it is recommended that the cables be secured to the DIN rail through use of a wire tie to 
prevent damage to the IntelliBase/USB HomeBase unit in case accidental or excessive force is applied to the cables. 
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Dolphin® QuadCharger
The Dolphin® QuadCharger provides intelligent battery management for NiMH (Nickel Metal Hydride) Dolphin 7400/7450 battery 
packs.

This device fully charges as many as four NiMH batteries in 2.5 hours.  Charging slots work independently to control charging 
and discharging of individual battery packs.  The QuadCharger is compatible with all models in the Dolphin® 7400/7450 family 
of hand held computers.

As battery packs charge, the charging circuitry follows a three-step process that senses changes in temperature and voltage and 
drops to a trickle charge when the packs are fully charged. This feature  allows the user to leave batteries in the charger 
indefinitely, which maintains the batteries at peak capacity without damage. The charger also resets and calibrates battery pack 
data to accurately show battery status on the Dolphin display.

The QuadCharger conditions and calibrates batteries for longer, more consistent performance. 

Dolphin QuadCharger Parts and Function

Top Panel 

Charging Pocket

The QuadCharger has four charging pockets for charging and/or conditioning batteries for Dolphin 7400/7450 terminals.  

Power Switch

Press and hold the Power Switch for approximately one second, then release, to turn on the QuadCharger. The Power Switch 
LED is green when the unit is on. To turn the charger off, press and hold the Power Switch for about two seconds and then 
release. This feature prevents the unit from being accidently turned off during use or on when not in use. 

Condition Switch

Press the Condition Switch to start a battery conditioning cycle. The orange Conditon Switch LED flashes during the conditioning 
cycle.

Status LEDs

A Status LED is located above each of the four battery pockets. 

Charging Pocket

Status LEDs

Status LEDs

Condition Switch & 
Condition LED

Power Switch & 
Power LED
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Rear Panel

Power Supply Connector

Use this connector to attach the power supply to the QuadCharger. The universal power supply accepts input voltages between 
90-265 volts.

Communications Port

The communications port is for factory use only in programming the QuadCharger.

Charging Batteries In The QuadCharger

Follow these steps to charge batteries in the QuadCharger:

1. Set up the charger for use 

2. Supply power

3. Insert batteries 

CAUTION: Do not attempt to recharge any battery pack in the Dolphin 7400/7450 QuadCharger that is not manufactured 
by HHP especially for this device.  To do so will void your warranty and could damage the Dolphin 7400/7450 
QuadCharger.  

Setting Up The QuadCharger
The Dolphin QuadCharger should be set up on any dry, stable surface. DIN rail slots on the bottom panel allow the charger to 
be wall or desktop-mounted for easily adapting the unit to your environment. 

The charger must be connected to a power source for any type of operation. 

Supplying Power To The QuadCharger
CAUTION: Using a non-HHP power cord voids your warranty and could result in serious damage to the Dolphin 
QuadCharger’s circuitry.

Locate the AC power cord that came with the Dolphin QuadCharger.  Plug the cord into the power supply connector on the back 
of the unit and then plug the power cord into a wall socket.  

Press and hold the Power Switch for approximately one second, then release, to turn on the Dolphin 7400 QuadCharger. The 
GREEN power LED will illuminate and the charger will undergo a self-diagnostic test.

Inserting and Removing Battery Packs 
To insert a battery pack, place the end of the battery without the locking tab into the bottom of the charging pocket and snap the 
battery into place with a hinging motion. Once the battery is properly seated, the orange status LED for that particular pocket will 
illuminate. 

For best results, battery packs should be at room temperature before recharging them; temperature has a marked effect on 
charging.  The recommended temperature range is 50° to 95° F (10° to 35° C).  

Rear Panel of Dolphin 7400/7450 Quad Charger

Power Supply ConnectorCommunications Port
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The LEDs indicate the charging status of batteries as described in the chart shown on the next page:

 

To remove a battery pack, push the locking tab down and pull the battery out from the charging pocket with a hinging motion.

Servicing The Battery Pack
To service battery packs, insert batteries into the charging pockets and press the Condition button. The Condition LED will flash 
during the conditioning cycle. This starts an automatic process in which batteries are completely discharged and then recharged 
to full capacity in eight hours. The Condition and Calibrate cycle resets and calibrates battery data so that the user gets longer, 
more consistent performance from the batteries. HHP recommends that battery packs should be serviced, or calibrated, once a 
month. 

Because the Dolphin QuadCharger is accumulating battery pack information during the entire Condition and Calibrate cycle, it is 
important not to remove the battery until the cycle has been completed and the Condition LED is no longer flashing. Batteries 
inserted after the “Condition and Calibrate” switch has been depressed will receive a standard charge. The chart below describes 
the Status LEDs during the Condition and Calibrate cycle:

Storing Batteries
To maintain top performance from batteries, follow the guidelines below when storing them:

Avoid storing batteries outside of the specified temperature range of -4 to 104° F ( -20 to 40°C) or in extremely high humidity.

For prolonged storage, do not keep batteries stored in a charger that is connected to a power source. 

During long-term storage, battery deactivation may tend to occur which may cause charging to stop early during recharging after 
storage. This issue can be handled by charging and discharging the battery several times. Also, the first charging after prolonged 
storage may yield a lower than normal capacity. While this will vary depending on the storage conditions, charging and 
discharging the battery several times will almost completely restore capacity. 

Status LED Description

Green
Charging is complete and 
battery is ready for service. 

Orange
Battery is being charged at a 
maximum charge rate

Red
Error was encountered during 
charge cycle

                              Status of LEDs during Charging Cycle

Status LED Description

Solid Green
Cycle is complete. Battery 
remains in trickle charge until 
removed from the charger.

Flashing Orange Battery is being conditioned

Solid Red Error was encountered during 
charge cycle

          Status of LEDs during Condition and Calibrate Cycle
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Troubleshooting

If you encounter problems with your Dolphin QuadCharger, refer to chart below for possible solutions. If problems persist, please 
contact HHP Technical Support. 

Problem Issue

The “CHARGING”  LED does not come on 
when I insert a battery pack into the 
Dolphin QuadCharger

Check the power connections on the 
Dolphin QuadCharger.  Also check to 
ensure the POWER switch is ON and the 
battery pack is properly seated.

The red status LED comes on during 
charging.

Try to charge the battery in one of the 
other charging pockets. If the red Status 
LED comes on again, then the problem is 
associated with the battery pack. If the red 
status stays with the charging pocket, the 
problem is associated with the charging 
circuity.

The red status LED remains on without a 
battery in the charging pocket.

An error occurred during the self-
diagnostic test for that particular charging 
pocket. Call HHP Product Service and 
request an RMA. See Chapter 9 for 
additional warranty and return 
information.
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Dolphin  Mobile Charging/Communication Cradles
As the hub of  Dolphin mobile data collection systems, Dolphin Mobile Charging/Communication cradles perform three important 
functions – power conditioning, communications and storage. Two versions of the mobile charging/communication cradles are 
available:

Dolphin Mobile IntelliBase™ for use with in-transit data collection applications.

Dolphin Mobile Base for use with in-premise warehouse data collection applications.

Power Conditioning

The charging/ communication cradles provide power to the Dolphin terminal to enable the terminal to charge its battery.

Ir/IrDA Optical Communications

The infrared, or Ir, communications port on the cradles connect with the IrDA port on the Dolphin terminal.  With no pins or 
contacts to break, Ir will work reliably for years. Reliable data communications at speeds of up to 115k baud can be transmitted 
by the both versions of the cradle. 

The Mobile IntelliBase and Mobile Base infrared connection to the terminal uses IrDA-compliant hardware and software for a 
standard reliable connection. 

Convenient Storage 

The Mobile IntelliBase and Mobile Base are safe, convenient storage receptacles for the Dolphin terminal.  
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Mobile IntelliBase and Mobile Base Parts and Functions

Front Panel
The front panel of the Mobile IntelliBase and the Mobile Base has one slot:

Front Panel of Dolphin Mobile IntelliBase

Terminal 
Well

DOCK LED

COMM              
LED

Spring-Arm Assembly
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Dolphin Terminal Well  Place the Dolphin in the well to communicate with a host device and/or  to charge the Dolphin’s battery.

LEDs  There are two LEDs on the front panels of the Mobile IntelliBase and Mobile Base charging/communication cradles.

1. Dock LED   Turns solid green when the Dolphin terminal is properly seated into the Dolphin Mobile IntelliBase.

2. COMM LED   Indicates the status of data transfer between the Host Device and the Dolphin terminal as described below:

Front Panel of Dolphin Mobile Base

Comm LED Description

Red LED Data is being sent from the Host Device to the 
Dolphin Mobile IntelliBase/Mobile Base.  

Green LED Data is being sent from the Dolphin Mobile 
IntelliBase/Mobile Base to the Host Device.

Orange LED Data is being sent at high data rates.

Terminal 
Well

DOCK LED
COMM              
LED

Spring-Arm Assembly
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Rear Panel

Rear Panel of Dolphin Mobile IntelliBase

RS-232 
Communications 
Port

Power Supply 
Connector

Mounting 
Bracket
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The power supply connector and RS-232 connector are located on the back panel of the unit:

Power supply connector  Use this connector to attach a power supply to the charging/communications cradle.  The power 
supply provides power for communications and battery charging.

RS-232 communications port  Use a standard serial cable to connect this port to a host RS-232 device. 

Rear Panel of Dolphin Mobile Base

 Power Supply 
ConnectorRS-232 

Communications 
Port

Locking Lever
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Bottom Panel of Mobile IntelliBase/Mobile Base
A four-position Baud Rate switch, located on the bottom of the Mobile IntelliBase, is used to select the communication baud rate.  
Switch positions and the corresponding baud rates are shown in the chart below. 

Baud Rate Table For Connecting To PCs

Baud Rate Table For Connecting To Modems

Powering the Dolphin Terminal

When seated in the Mobile IntelliBase/Mobile Base, the Dolphin terminal receives the power it needs to charge the battery and 
to run its internal circuitry.

The Dolphin terminal can be stored indefinitely in the charging/communication without damage to the terminal or the Mobile 
IntelliBase/Mobile Base.  Keep the mobile charging/communications cradle plugged in so that the Dolphin terminal battery pack 
stays fully charged.

Charging A Dolphin Terminal
The Mobile IntelliBase/Mobile Base supplies charging power to the Dolphin terminal so that the terminal can monitor the charging 
of its battery pack. This charging method protects the battery from being damaged by overcharging.  Therefore, the Dolphin 
terminal may be stored indefinitely in the Mobile IntelliBase/Mobile Base without damage to the terminal, the battery pack, or the 
Mobile IntelliBase/Mobile Base.

To charge a Dolphin terminal, follow these steps:

1. Insert a battery pack into the Dolphin terminal.

2. Place the terminal, imager engine window up and the LCD visible, in the terminal well of the Mobile IntelliBase/Mobile Base.  

3. Let it glide down into the well until it stops.  

4. Once the Dolphin terminal is properly seated, the Dock LED on the Mobile IntelliBase/Mobile Base will be solid GREEN.

Deep-Cycling Batteries
For maximum battery life, HHP recommends that you deep-cycle (service) the battery twice before initial use and once a month 
thereafter. Since the Dolphin 7400 Mobile Intellibase and Mobile Base do not have deep-cycling capabilities, it is recommended 
that you use the Battery Conditioning Utility software, the IntelliBase+ or a Dolphin QuadBattery Charger. See the Battery 
Management section in Chapter 3 for more information.

Baud Rate Switch 1 Switch 2 Switch 3 Switch 4

115200 OFF ON ON ON

57600 ON OFF OFF ON

38400 ON OFF ON ON

19200 ON ON OFF ON

9600 ON ON ON ON

Baud Rate Switch 1 Switch 2 Switch 3 Switch 4

115200 OFF ON ON OFF

57600 ON OFF OFF OFF

38400 ON OFF ON OFF

19200 ON ON OFF OFF

9600 ON ON ON OFF
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Setting Up For Communications with the Mobile IntelliBase/Mobile Base

The Mobile IntelliBase RS-232 interface allows the Dolphin terminal to communicate to a personal computer, modem, or any 
standard RS-232 device using a standard serial cable and communications software.

The IrDA 1.0 software stack is integrated into the Mobile IntelliBase/Mobile Base to allow communication between the cradle and 
devices such as modems or printers that are not IrDA ready or do not communicate with a half duplex serial protocol. This allows 
any full or half duplex RS-232 device to communicate through the IntelliBase with no IrDA protocol software. See Tables 2 or 3 
for the baud rate switch settings.

Installing The Dolphin Mobile IntelliBase
Mounting the Mobile IntelliBase Spring Arm Assembly

The adjustable mounting bracket holds the terminal securely in place and gives the user a variety of options for mounting the 
Mobile IntelliBase. See the directions below for mounting the bracket.

To attach the bracket:

1. Loosen the  turnscrew located on the side of the bracket.

2. Attach the bracket to the ball joint on the back of the Mobile IntelliBase and tighten the turnscrew.

Ball joint

Turnscrew
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Installing The Dolphin Mobile Base
The Mobile Base has two mounting options - a clamp style for in-premise applications and a standard RAM mount for other 
mobile applications that allow the Mobile Base to be mounted according to specific needs. The spring-arm assembly holds the 
terminal securely in place. 

To attach the bracket:

1. Loosen the  turnscrew located on the side of the bracket.

2. Attach the bracket to the ball joint on the back of the Mobile IntelliBase and tighten the turnscrew.

Ball joint

Turnscrew
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Connecting the Cables

Connect the Mobile IntelliBase/Mobile Base to the host computer or other device by plugging an RS-232 serial cable into the RS-
232 Communications Port on the rear of the cradle.  Plug the other end of the RS-232 serial cable into the correct port on the 
host RS-232 device. 

The wiring of your cable depends on whether the other device is set up as a DCE (Data Communications Equipment) or DTE 
(Data Terminal Equipment) device. 

The Mobile IntelliBase/Mobile Base Communication Port is configured as a DCE device.  To communicate with a DTE device 
such as a computer, use a standard (or straight-through) RS-232 cable.  To communicate with a DCE device, use either a null 
modem adapter in line with a standard RS-232 cable, or a null-modem serial cable. 

You can make your own cables by following the pin configuration in the chart below.  To do so, you must determine if your host 
RS-232 device is 9-pin or 25-pin, and whether it is configured as a DCE or DTE device.

Supplying Power to the Dolphin Mobile IntelliBase and Mobile Base

The Mobile IntelliBase and Mobile Base can both be powered from either a 12 -48 volt DC source. Power is connected to the 
input power connector located on the rear of the Mobile IntellieBase. 

HHP recommends that you leave the Mobile IntelliBase connected to its power source at all times, so that it is always ready to 
use.

Setting the Baud Rate 

After connecting the cables and supplying power to the Mobile IntelliBase, set the baud rate switch. Refer to the Baud Rate 
Tables earlier in this section for guidance on setting the switch.

HomeBase /Host 
Port (DCE)

IBM AT DB9 
(DTE)

IBM XT 
DB25 (DTE)

Modem DB25 
(DCE)

Pin /  Input Signal

2   /  (RD) 2 3 2

3   /  (TD) 3 2 3

5   /  (SG) 5 7 7

4   /  (DTR) 4 20 6

6   /  (DSR) 6 6 20

7   /  (RTS) 7 4 5

8   /   (CTS) 8 5 4
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Configuring the Dolphin Terminal
The Communications Properties must be configured on Dolphin 7400/7450 terminal in order for it to communicate with the Mobile 
IntelliBase/Mobile Base.

To set Communications Properties:

1. Select Start>Settings>Control Panel>Communication Settings. 

2. Select the PC Connection tab.

3. Select the desired option for connecting to the desktop computer. Choose IrDA for Mobile IntelliBase IrDA connection  and 
click OK.

4. Place the Dolphin in the Mobile IntelliBase.

5. On the Dolphin 7400 desktop, double-tap on ActiveSync.

Communications Properties
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Warranty, Support and Service
Limited Warranty

Hand Held Products, Inc., d/b/a HHP ("HHP") warrants its products to be free from defects in materials and workmanship and to 
conform to HHP’s published specifications applicable to the products purchased at the time of shipment.  This warranty does not 
cover any HHP product which is (i) improperly installed or used; (ii) damaged by accident or negligence, including failure to follow 
the proper maintenance, service, and cleaning schedule; or (iii) damaged as a result of (A) modification or alteration by the 
purchaser or other party, (B) excessive voltage or current supplied to or drawn from the interface connections, (C) static electricity 
or electro-static discharge, (D) operation under conditions beyond the specified operating parameters, or (E) repair or service of 
the product by anyone other than HHP or its authorized representatives.

This warranty shall extend from the time of shipment for the duration published by HHP for the product at the time of purchase 
("Warranty Period").  Any defective product must be returned (at purchaser’s expense) during the Warranty Period to HHP’s 
factory or authorized service center for inspection.  No product will be accepted by HHP without a Return Materials Authorization, 
which may be obtained by contacting HHP.  In the event that the product is returned to HHP or its authorized service center within 
the Warranty Period and HHP determines to its satisfaction that the product is defective due to defects in materials or 
workmanship, HHP, at its sole option, will either repair or replace the product without charge, except for return shipping to HHP.

EXCEPT AS MAY BE OTHERWISE PROVIDED BY APPLICABLE LAW, THE FOREGOING WARRANTY IS IN LIEU OF ALL 
OTHER COVENANTS OR WARRANTIES, EITHER EXPRESSED OR IMPLIED, ORAL OR WRITTEN, INCLUDING, WITHOUT 
LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

HHP’S RESPONSIBILITY AND PURCHASER’S EXCLUSIVE REMEDY UNDER THIS WARRANTY IS LIMITED TO THE 
REPAIR OR REPLACEMENT OF THE DEFECTIVE PRODUCT.  IN NO EVENT SHALL HHP BE LIABLE FOR INDIRECT, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, AND, IN NO EVENT, SHALL ANY LIABILITY OF HHP ARISING IN 
CONNECTION WITH ANY PRODUCT SOLD HEREUNDER (WHETHER SUCH LIABILITY ARISES FROM A CLAIM BASED 
ON CONTRACT, WARRANTY, TORT, OR OTHERWISE) EXCEED THE ACTUAL AMOUNT PAID TO HHP FOR THE 
PRODUCT.  THESE LIMITATIONS ON LIABILITY SHALL REMAIN IN FULL FORCE AND EFFECT EVEN WHEN HHP MAY 
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH INJURIES, LOSSES, OR DAMAGES.  SOME STATES, PROVINCES, 
OR COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATIONS OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

All provisions of this Limited Warranty are separate and severable, which means that if any provision is held invalid and 
unenforceable, such determination shall not affect the validity of enforceability of the other provisions hereof.

The limited duration of the warranty for the Dolphin 7400 and Dolphin 7450 terminals is as described below:

• Terminals with an integrated imager are covered by a two-year limited warranty. Terminals with an ALR integrated laser 
engine are covered by a one-year limited warranty. If equipped with a touch screen display, the display is covered by a one-
year limited warranty. If equipped with a Type II PCMCIA integrated radio card, the radio card is covered by a two-year limited 
warranty.

The limited duration of the warranty for the Dolphin HomeBase, IntelliBase, IntelliBase+, USB HomeBase, Mobile IntelliBase and 
QuadCharger is for one year. 

The limited duration of the warranty for batteries is one year. The battery life will be greatly increased when following the specific 
battery instructions in the user guide. Rechargeable batteries are highly susceptible to “battery memory” and if instructions are 
not followed, the amount of hours of usage and the life of the battery are greatly reduced.

Batteries returned to HHP in this reduced state may or may not be replaced under this warranty.

Use only power adapters approved for use by HHP.  Failure to do so may result in improper operation or damage to the unit and 
will void the warranty.

HHP, Inc. extends these warranties only to the first end-users of the products.  These warranties are non-transferable.

How Problems Should Be Handled

Should the Dolphin terminal or any of the peripherals prove to be defective within the stated warranty period from the of date of 
purchase, return the product, as described in the RMA procedures below, and we will, at our option, repair or replace the product, 
to whatever extent HHP deems necessary to restore the product to proper operating condition, without any charge to you.

Return Information

If you purchased the product from an Authorized HHP Reseller, contact the Reseller with the unit's serial number.  Your Reseller 
will contact Hand Held, on your behalf, to arrange for the unit to be serviced.

If you purchased the product directly from Hand Held, or have been instructed by your Reseller to contact HHP directly, call the 
Customer Services Department in your area to request a Repair Maintenance Authorization (RMA) number.  
15 - 1



North  America:

(TEL)  (800)-782-4263 

(FAX) (704)-566-9904

Latin America

(TEL) (239)-263-7600

(FAX) (239)-263-9689

Europe, Middle East and Africa:

TEL) Int+31 (0) 40 29 01 600

(FAX) Int+31 (0) 40 24 25 672

The United Kingdom:

(TEL) Int+44 (0) 1 925 240055 or Int+353 1 216 0070

(FAX) Int+44 (0) 1 925 631280 or Int+353 1 925 6353

Asia/Pacific:

(TEL) Int+852-2511-3050 or 2511-3132

(FAX) Int+852-2511-1355

Japan:

(TEL) Int+81-3-5212-7392

(FAX) Int+81-3-3261-7372

You must have an RMA number to receive service from any of HHP’s repair facilities.  Failure to obtain an RMA number before 
shipping your product to this repair facility can delay the processing of your repair request.  

When calling for service at any of our repair facilities, please be prepared to give the following information:

• ·Product's type and serial number 
• ·Brief description of problem 
• ·Dated Proof-of-Purchase

Place the product in its original packaging with a copy of your original invoice and ship the product prepaid to the appropriate 
address below. Write the RMA number on the mailing label under the address.
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If your equipment is still covered under the initial end-user's product warranty, please notify the Product Services Representative 
when you call.  Please include a copy of the original invoice in the package to avoid possible service delays.  For your protection, 
we recommend you insure any equipment being sent to HHP.

After repair or replacement of the equipment, HHP will ship the product, at our cost, to your location.  Non-warranty repairs will 
be returned, at the customer's expense, unless otherwise requested.  Units currently under a service agreement will be shipped 
per the service agreement.

Please make note of the RMA number (if required) before shipping and the product's serial number for future reference.

How To Extend Your Warranty

HHP offers a variety of service plans on our hardware products.  These agreements offer continued coverage for your equipment 
after the initial warranty expires.  For more information, contact your HHP sales representative, customer account representative 
or the Product Service Marketing Manager or your Authorized Reseller. 

Application Support

If you have a question or problem with your Dolphin terminal or Dolphin peripheral, you can get technical assistance from HHP's 
Application Support department. 

North and South America:

HHP

Products Services Department

7510 East Independence Blvd., #100

Charlotte, NC 28227-9411

Europe, Middle East and Africa :

Nijverheidsweg 9

5627 BT Eindhoven

The Netherlands

The United Kingdom :

Dallam Court

Dallam Lane Warrington

Cheshire WA2 7LT

United Kingdom

Asia/Pacific

10/F Tung Sun Commercial Centre

194-200 Lockhart Road

Wanchai, Hong Kong

Japan Office

Bon Marusan 8F

3-5-1 Kanda-Jinbocho

Chiyoda-ku

Tokyo 101, Japan

Latin America Office

5117 Castello Drive

Suite 1

Naples, FL 34103
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North America:

(TEL)  1-(800) 782-4263 

8 a.m. and 6 p.m., Eastern Time, Monday 
through Friday

support@hhp.com

Europe, Middle East and Africa:

(TEL) Int+31-40 242 4486

9 a.m. - 5 p.m., Central European Time, 
Monday through Friday

euro_support@hhp.com

The United Kingdom:

(TEL)+44 1925  240055

9 a.m. - 5:30 p.m., UK Time, Monday 
through Friday

euro_support@hhp.com

Asia:

(TEL)Int+852-2511-3050 or 2511-3132

asia_support@hhp.com

Latin America:

(TEL) (239) 263-7600

la_support@hhp.com
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Appendix A 
Use the keyboard shortcuts in the chart below to navigate the Dolphin 7400 and 7450 terminal keyboards.

Windows Keyboard Shortcuts

Press To

CTRL + C Copy

CTRL + X Cut

CTRL + V Paste

CTRL + Z Undo

DELETE Delete

CTRL + RIGHT ARROW Move the insertion point to the beginning 
of the next word.

CTRL + LEFT ARROW Move the insertion point to the beginning 
of the previous word.

CTRL + DOWN ARROW Move the insertion point to the beginning 
of the next paragraph.

CTRL + UP ARROW Move the insertion point to the beginning 
of the previous paragraph.

SHIFT with any of the arrow keys Select more than one item in a window or 
on the desktop, or select text within a 
document.

CTRL+A Select all.

ALT+ENTER View properties for the selected item.

ALT+TAB Switch between open items.

ALT+ESC Cycle through items in the order they were 
opened.

ALT + Tap on Touch screen Right click

CTRL+ESC Display the Start menu.

ALT+Underlined letter in a menu name Display the corresponding menu.

Underlined letter in a command name on 
an open menu

Carry out the corresponding command.

BACKSPACE View the folder one level up in My 
Computer or Windows Explorer.

ESC Cancel the current task.
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Using the Modifier Keys

The Dolphin 7400/7450 terminal keyboard features the standard Windows modifier keys, Alt, Ctrl and Shift. The Shift key only 
modifies the next key pressed; it must be pressed before each key you wish to make lower case. For multiple lower case 
characters, hold the Shift key down with one hand while typing with the other. Functions of the Alt and Ctrl keys are dependent 
on the software application in use.

There are two additional modifier keys located on the bottom row of the keyboard. The Red and Blue keys only modify the next 
key pressed; these keys must be pressed and released before each key you wish to modify to the Blue or Red case. Use these 
keys in combination with other keys to type the corresponding color-coded characters and functions. See the charts below for 
key combinations that access the functions and special characters using these keys.

43-Key Alpha/Numeric Keyboard

Blue Key Functions & Characters For 43-Key Alpha/Numeric Keyboard

Key Combination Function/Special Character

Double tap Blue key Activate/Deactivate Mouse Utility

Blue key +  D - (minus)

Blue key +  H _ (underscore)

Blue key +  L =

Blue key +  P +

Blue key +  Q ;

Blue key +  R :

Blue key +  S *

Blue key +  T /

Blue key +  U @

Blue key +  X \

Red Key Functions & Characters For 43-Key Alpha Shifted Numeric Keyboard

Key Combination Function/Special Character

Red key +  ESC Lightens Contrast*

Red key +  TAB Darkens Contrast*

Red key + SFT Toggles on Caps Lock

Red key +  Q F1

Red key +  R F2

Red key +  S F3
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* Exit the mouse utility prior to adjusting the contrast.

Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 43-key version of the Dolphin 7400/7450 keyboard.

Red key +  T F4

Red key +  U F5

Red key +  V F6

Red key +  W F7

Red key +  X F8

Red key +  Y START

Red key +  Z INS (insert)

Red key +  SP BKSP (backspace)

Red key +  BACKLIGHT KEY DEL (delete)

Key Combinations Using NUM & SFT Keys

Key/Key Combination Function/Special Character

NUM + SFT + A !

NUM + SFT + B @

NUM + SFT + C #

NUM + SFT + E $

NUM + SFT + F %

NUM + SFT + G ^

NUM + SFT + I &

NUM + SFT + J *

NUM + SFT + K (

NUM + SFT + M >

NUM + SFT + N )

NUM + SFT + O <

Red Key Functions & Characters For 43-Key Alpha Shifted Numeric Keyboard

Key Combination Function/Special Character
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35 Key Numeric/Alpha 

Key Combinations Using Blue & SFT Keys

Key/Key Combinations Function/Special Characters

Blue + SFT + T ?

Blue + SFT + X |

Miscellaneous Key Combinations

Key/Key Combinations Function/Special Characters

NUM + ALT + 3 + 9* ‘

NUM + ALT + 3 + 4*

*Hold the ALT key down as you type in the numbers.

“

Blue Key Functions & Characters For 35-Key Numeric/Alpha Keyboard

Key Combination Function/Special Character

Double tap Blue key Activate/Deactivate Mouse Utility

Blue key +  . +

Blue key +  , -

Blue key +  F1 ;

Blue key +  F2 :

Blue key +  F3 /

Blue key +  F4 \

Blue key +  SP _

Blue key + DEL @

Blue key + 0 (zero) =
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Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 35-key version of the Dolphin keyboard.

56 Key Full Alpha Numeric

Key Combinations Using ALPHA & SFT Keys

Key/Key Combination Function/Special Character

ALPHA + SFT + 1 !

ALPHA + SFT + 2 @

ALPHA + SFT + 3 #

ALPHA + SFT + 4 $

ALPHA + SFT + 5 %

ALPHA + SFT + 6 ^

ALPHA + SFT + 7 &

ALPHA + SFT + 8 *

ALPHA + SFT + 9 (

ALPHA + SFT + 0 )

ALPHA + SFT + . (period) >

ALPHA + SFT + , (comma) <

Miscellaneous Key Combinations

Key/Key Combinations Function/Special Characters

ALT + 3 + 9* ‘

ALT + 3 + 4*

*Hold the ALT key down as you type in the numbers.

“

Blue Key Functions & Characters For 56-Key 
Full Alpha Numeric Keyboard

Key Combination Function/Special Character

Double tap Blue key Activate/Deactivate Mouse Utility

Blue key +  . +
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Blue key +  , -

Blue key +  A ;

Blue key + B :

Blue key +  C /

Blue key +  D \

Blue key +  E _

Blue key +  F @

Red Key Functions & Characters for 56-Key
Full Alpha Numeric Keyboard

Key Combination Function/Special Character

Red key +  ESC Lightens Contrast*

Red key +  TAB Darkens Contrast*

Red key + SFT Toggles on Caps Lock

Red key +  A F1

Red key +  B F2

Red key +  C F3

Red key +  D F4

Red key +  E F5

Red key +  F F6

Red key +  G F7

Red key +  H F8

Red key + I F9

Red key + J F10

Red key + K F11

Red key + L F12

Red key + M F13

Red key + N F14

Red key + O F15

Blue Key Functions & Characters For 56-Key 
Full Alpha Numeric Keyboard

Key Combination Function/Special Character
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* Exit the mouse utility prior to adjusting the contrast.

Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 56-key version of the Dolphin keyboard.

Red key + P F16

Red key + Q F17

Red key + R F18

Red key + S F19

Red key + T F20

Red key + U F21

Red key + V F22

Red key + W F23

Red key + X F24

Red key + Y Z

Key Combinations Using SFT & Number Keys

Key/Key Combination Function/Special Character

 SFT + 1 !

SFT + 2 @

SFT + 3 #

SFT + 4 $

SFT + 5 %

SFT + 6 ^

SFT + 7 &

SFT + 8 *

SFT + 9 (

SFT + 0 )

SFT + . (period) >

SFT + , (comma) <

Red Key Functions & Characters for 56-Key
Full Alpha Numeric Keyboard

Key Combination Function/Special Character
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Miscellaneous Key Combinations

Key/Key Combinations Function/Special Characters

ALT + 3 + 9* ‘

ALT + 3 + 4*

*Hold the ALT key down as you type in the numbers.

“
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Appendix B
Dolphin 7400/7450 Scan Maps
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